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Get Help

There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications

Some application pages have help icons ® to give you access to contextual help. If you don't see any help icons on
your page, click your user image or name in the global header and select Show Help Icons. If the page has contextual
help, help icons will appear.

Get Training

Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community

Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Share Your Feedback

We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!
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1 Introduction and Setup Overview

How to Use this Playbook

This playbook provides the steps sales administrators can use to configure sales dashboards for their organization.
Administrators can configure any number of sales dashboards for different audiences with the content provided by
Oracle and with the content they create.

1. Familiarize yourself with the types of information you can display and the prerequisites.

2. To configure your dashboards, follow the order of steps in the setup overview provided in the topic: Overview of
Sales Dashboard Configuration Steps.

3. Review the Using Sales for Redwood guide to learn how salespeople use sales dashboards and the rest of the
sales application.

4. The FAQ chapters in this guide provide common troubleshooting information.

Note:

- After you create your own custom versions of sales dashboard features, the underlying code provided by
Oracle in those features is no longer automatically updated. Any updates are your organization's responsibility.

Oracle Visual Builder Studio (VB Studio) is a full-blown development environment. This playbook doesn't cover
all of the steps required to set up or use VB Studio. For more information on using VB Studio, see the Extending
Oracle Cloud Applications with Visual Builder Studio guide.

What's a Sales Dashboard?

A sales dashboard is a centralized workspace that provides key sales metrics and insights in a single view. It aggregates
data from sources such as opportunities, leads, accounts, tasks, and appointments, displaying this information through
interactive visualizations, tables, and Key Performance Indicators (KPIs). Salespeople can use global search and filters to
quickly find records or focus on specific aspects of sales data (including pipeline, forecasts, or account activity), without
switching between multiple systems

In addition to reporting, the sales dashboard supports decision-making and workflow management. Features such as
drill-down views, account summaries, and content containers allow users to move from high-level metrics to individual
records efficiently. Salespeople can update records, follow up on opportunities, and assign tasks directly within the
dashboard.

The dashboard also supports integration with external analytics tools, such as Tableau, PowerBlI, Oracle Analytics,
enabling access to advanced analytics and predictive insights within the same workspace.

Sales administrators, using the steps in this guide, can create any number of sales dashboards, each suited to a different
role or individual. Personalization options let each salesperson create their own version of the dashboard with layouts,
charts, and filters that best fit their needs, balancing consistency and flexibility.

For salespeople, the sales dashboard streamlines access to information and daily tasks, reducing time spent searching
for data or generating reports. Managers can monitor team performance and identify risk areas at a glance, while
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team members have clear visibility into their pipeline and activity. By combining metrics, workflow management, and
analytics, the sales dashboard serves as both a reporting tool and a central hub for sales execution.

Key Sales Dashboard Features

Feature Description

1 Ask Oracle bar that you can use to search for sales information and to filter the contents of the sales
dashboard active tab.

2 Filters to filter the information displayed in the active tab.

3 The Edit Page Layout button that you can use to personalize your sales dashboard.
4 The top of each tab can include Key Performance Indicators (KPIs).

5 Tab body with interactive visualizations and tables.

Sales Dashboard e e Edit Page Layout
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Overview of Sales Dashboard Setup Steps

Use this overview to guide you through the initial setup of sales dashboards. You must create your own sales
dashboards regardless of the types of edits you want to make. Even a small wording change requires you to create your
own. You can't edit any of the sales dashboard content provided by Oracle directly.
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Step
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ORACLE

Description

Get a quick start building your sales dashboards by importing sample content provided by Oracle.

The content you can download from Oracle Cloud Customer Connect includes Oracle Transactional Business Intelligence (OTBI) r
accompanying visualization configurations, and a sample sales manager dashboard.

The OTBI reports cover accounts, activities, forecasts, leads, opportunities, orchestrations, and quotes. You can edit the content t
it in your own dashboards.
Enable 2 Al agents that salespeople can use to create charts from queries they enter in the Ask Oracle bar (Sales Analyzer) and ge

existing charts (Narrative Insights).

Create the shell of your sales dashboard content by duplicating one of the 2 dashboards provided by Oracle. In VB Studio, the das
as 2 instances of the metrics container.

Who can view a sales dashboard is determined by the condition and the position of the metrics container instance in the hierarch
To ensure you can view the copy during setup, clear the conditions to make the dashboard visible to everyone.

Create the charts, tables, and lists for display in sales dashboards. A number of tools are available. Which you'll want to use depen
data and the complexity of what you need.

For example, you can create simple charts using the Sales Analyzer Al agent by entering your query in the Ask Oracle bar in the d
For more complex charts and those originating from OTBI, you can use the Visualization Configuration tool (covered in this guide
(covered in the How do | get started with Express Reports? playbook.)

Within the dashboard shell metrics container, create the metric card for each tab you're adding.

The metric card is the top of the tab that's always visible.

Create the shell for your tab content by duplicating one of the contents containers provided by Oracle.

Edit the content container condition to link it to the metric card that you created for the tab.

In each tab, you can have up to 5 sections displaying different sales information as tables, lists, and charts.
Before you start adding content to the contents container for your tab, review how the layout style controls the display of the sect

your section in the tab depends on the number of sections you add and the section's position on the tab.

Create the sections that display the content in the tab.
The parameters you enter are different for displaying a table, a list, a visualization, and for embedding a report from Oracle Fusior

For adding tables and lists, a layout specifies which attributes appear as columns, in which order, and at which relative widths.

The layouts, which are specific to each business object, already include key information, but you can add attributes or change the

Enable search for custom objects and fields from the Ask Oracle bar. Standard sales objects and fields are already enabled for sea
similar procedure to change which fields are used in search and show in the search results.


https://docs.oracle.com/pls/topic/lookup?ctx=en/cloud/saas/sales&id=GSWER

Oracle Fusion Cloud Sales Automation Chapter 1
How do | configure the Sales Dashboard in the Redwood Introduction and Setup Overview

User Experience?

Step Description

1 Expose filters that salespeople can use to narrow down the scope of the sales information they view on the sales dashboard tabs.
can narrow down the information to a specified period of time or select specific team members.

12 Specify which of the sales dashboard tabs you want to display by default when users open the sales dashboard.

To specify which tab users see, you copy the ID of tab's metric card into the sales dashboard constant defaultMetricCard.

13 Salespeople can create records directly from the Ask Oracle bar in the sales dashboard. You can specify which Create actions are ¢
the Smart Actions work area in Application Composer.

You can also create global actions to open published Al agents directly from the Ask Oracle bar.

14 Enable sales dashboard personalization. Once enabled, salespeople can create their own personal versions of the sales dashboarc
provide.

Overview of the Starter Sales Dashboard Designs
Provided in the Application

Oracle provides you with 2 predefined sales dashboards that you can copy and configure.

Sales Dashboard for the Sales Representative
The dashboard includes two tabs:

- My To-Dos
The My To-Dos tab includes these components:

o Tasks Due in the Next 30 Days table
o My Appointments list
o My Overdue Tasks list

- Pipeline
The Pipeline tab includes these components:

o My Open Opportunities table
o My Favorite Opportunities list
o My Open Leads list
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Sales Dashboard for the Sales Manager

The sales manager dashboard includes the same two tabs, but tailored to managers:

- To-Dos

Chapter 1
Introduction and Setup Overview

The sales manager To-Dos tab includes these components all drawn from saved searches:

o

o

o

o

[e]

Opportunities at Risk table
My Appointments list

My Team's Open Tasks list
My Open Tasks list

My Team's Overdue Tasks list

- Pipeline

The Pipeline page for the sales manager includes these components:

o

o

o

My Team's Opportunities table

My Favorite Opportunities list

My Team's Open Leads list

Lead Amounts by Team Member visualization

My Team's Performance visualization

Sales Dashboard VB Studio Component Basics

Here's a quick overview of how the Sales Dashboard is represented in Oracle Visual Builder Studio components.

The Tabs on Your Sales Dashboard: Metric Cards and Contents Containers

Each tab in your dashboard is composed of two Oracle Visual Builder Studio fragments that hold the tab content:

- Metric Card (identified by callout 1in the following screenshot)

A metric card holds the information at the top of the tab, which is always visible on the dashboard even when
the tab isn't selected. It contains the tab title, and other optional information. The predefined Pipeline metric
card for sales managers, for example, calculates and displays the sum of opportunity revenue.

All of the metric cards in a sales dashboard are listed in a Metrics Container. The metrics container, discussed
in the next section, forms the shell of your sales dashboard.
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- Contents Container (callout 2)

The contents container holds the information in the tab. You can add up to 5 sections with tables,
visualizations, and lists to each contents container.

The predefined pipeline contents container in the sales manager dashboard provide by Oracle, for example,
displays a table of opportunities in the first section. Other sections display My Appointments, My Team's Open
Tasks, My Open Tasks, and My Team's Overdue Tasks. All present information from different saved searches.

Sales Dashboard
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To the user, the metric card and the contents container form a single unit. However, the metric card and the contents
container are separate entities in VB Studio. You must link them together in VB Studio to make them appear as a single
tab.

Metrics Container Instance: The Shell of Your Dashboard

In VB Studio, the contents of your sales dashboard is represented by a metrics container instance. Each metric container
instance contains a list of the metric cards ( the tabs that users see).

This screenshot of a sales dashboard includes 2 tabs. The metric container instance includes 2 metric cards, one for
each tab.
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Sales Dashboard
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You create a rule for each metric container instance that determines who gets to see the sales dashboard it represents.

Here's a screenshot of how the metric containers are represented in Oracle Visual Builder Studio. The screenshot shows
2 metric containers for the 2 sales dashboards provided by Oracle.

Callout Number Description

1 The metrics container for the predefined sales manager dashboard.
The metrics containers Oracle provides are listed under the Built-in Rules heading.
The metrics containers you create are listed under Extension Rules.
2 Conditions specify who sees this dashboard.
The predefined sales manager dashboard can be viewed only by the job roles listed. All other users see

the sales representative dashboard because its condition is set to "Always Show".

3 Metric cards (the tabs in the dashboard) are listed under the Sections Included in Rule heading. The
order of the metric cards determines the order of the tabs.
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Metrics Container Rules
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Contents Containers: Your Tab Content

The Contents Container specifies the contents of each tab in the sales dashboard. The contents container condition
references the metric card in the metrics container.

Contents Container Anatomy

Callout

ORACLE

Description

Each rule is a contents container instance. For example, the Sales Representative- Pipeline Content
contents container provided by Oracle specifies which pipeline visualizations sales representatives see
in the Pipeline tab.

Because Oracle provides separate sales dashboards for sales representatives and sales managers,
there's a separate pipeline contents container for sales managers listed under the Built-In Rules
heading.

Click the Duplicate icon to duplicate the content provided by Oracle so you can edit it.

The conditions in each contents container reference the metric card which forms the top of the tab in
the sales dashboard.

The items listed under the Sections Included in Rule heading specify what users see in the tab and in
which order.
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What You Can Display and How You Create It

You can display a variety of interactive visual elements on your dashboard. These include:
- Key Performance Indicators (KPIs)
- Charts
- Tables
« Lists

- Embedded Oracle Fusion Data Intelligence Components

Which Tools You Can Use for What

Here's a table summarizing which tools and data sources you can use to create the different display elements.

Tool and Data Source KPI (Metric Card) Tables Lists Charts
Visualization Configuration = Yes Yes Yes Yes
(Adaptive Search)

Visualization Configuration = Yes Yes No Yes
(OTBI)

Express Reports (OTBI) No No No Yes

ORACLE
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Tool and Data Source KPI (Metric Card) Tables
Sales Analyzer Al Agent Yes Yes
(Adaptive Search)

About the Tools

- Visualization Configuration

Chapter 1
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Lists Charts

No Yes

The Visualization Configuration tool lets you create content for your dashboards from data in both Adaptive
Search and from Oracle Transactional Business Intelligence (OTBI):

o Visualizations from Adaptive Search saved searches

You can build visualizations from the default saved search for the object and add filters in the tool or
create visualizations from individual saved searches.

A saved search is a reusable query created in Adaptive Search that retrieves data directly from sales
objects such as opportunities, accounts, leads, and tasks. Saved searches are flexible and can be used
across multiple dashboard components, including metric cards, tables, lists, and charts. They're ideal
for sales users who need quick access to operational data (for example, “My Open Opportunities” or
“Overdue Tasks”) and require the ability to drill down into record-level details.

When to use saved searches:

- For real-time operational sales data
- When actionable records are needed in tables or lists
- When the same data set will be used in multiple dashboard components

o Visualizations from OTBI analyses

An OTBI analysis is a report created with Oracle’s transactional business intelligence layer. It enables
users to combine data from multiple subject areas, apply advanced filters, and create custom
aggregations. OTBI analyses can populate metric cards, tables, and charts, but can't directly generate
lists. They're ideal for complex reporting, trend analysis, or when KPIs require multidimensional data,
such as revenue by product and region.

When to use OTBI analyses:

- To gain analytical insights across multiple objects or subject areas
- To build KPIs needing complex calculations or aggregations
- To support visualizations with advanced analytical queries

You can open the Visualization Configuration tool from the home page or directly from a URL. (http://<server-
address>/fscmUIl/redwood /cx-analytics /application/container/dvconfig/).

ORACLE
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Express Reports

The Express Reports tool makes it easy to quickly create reports from OTBI analyses. No tables, lists, or
metric cards are supported. Each report consists of a chart and a table. The sales dashboard only displays the
visualization part of report created in Express Reports. The table isn't displayed.

The tool is targeted at salespeople without advanced OTBI report building skills. It's ideal for situations where
users need quick visual insights without help from administrators or use of advanced reporting tools.

When to use express reports:

o For quick visual analysis
o When a salesperson needs a chart without building a report in OTBI or configuring saved searches.

You can open the Express Reports tool from the home page or directly from a URL.(http://<server-address>/
fscmUI/redwood/cx-analytics/application/container/report/reports).

To learn more about Express Reports, see the playbook How do | get started with Express Reports?.

- Sales Analyzer Al agent

You can create simple charts and KPIs (Metric Cards) from Adaptive Search by entering a query in the sales
dashboard Ask Oracle bar. The Sales Analyzer agent does the rest.

If you preface your prompt by the verb "show", the Sales Analyzer agent creates simple charts from the
attributes enabled for Adaptive Search. You can group data by 1 attribute. For example, you can have the Sales
Analyzer create a bar chart showing the number of opportunities for each of your team members by sales
stage, but you can't generate a stacked chart that shows the number of opportunities and revenue by sales
stage.

When you omit the verb "show" and include a prompt that asks for a number or a sum, such as "number
of opportunities won this quarter”, the agent creates a KPI that you can use for the top of each tab in the
dashboard.

With sales administrator privileges, you can save the charts and KPIs generated by the agent in the library of
dashboard content and add it to your personal dashboard using personalization or to sales dashboard designs
in Oracle Visual Builder Studio.

Related Topics

Key Performance Indicators (KPIs)

Charts

Tables

Lists

Embedded Oracle Fusion Data Intelligence Components

Key Performance Indicators (KPIs)

In the metric cards that form the top of each tab, you can display Key Performance Indicators (KPIs) that highlight critical
values such as total amounts of pipeline revenue, closed revenue, or the number of overdue tasks. The KPIs provide an
at-a-glance view of performance against goals and help salespeople prioritize actions quickly.

1
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A metric card can have up to 5 different elements highlighted in the screenshot.

Anatomy of a Metric Card (KPI)

Callout Field Description

1 Name The title of your dashboard tab.

2 Badge Displays badges you specify for different value
ranges.

3 Primary Metric (Secondary Metric) You can display up to 2 metrics.

In this example, it's the sum of the Deal Size
(Primary Metric) and the count (Secondary
Metric).

4 Description One-line description that you enter or that's

filled in dynamically.

o__... Deal Registrations  HIGH
$189.12K (22) « e

o__.. Deals by Partner Track

What Tools to Use to Create KPIs
Use the Visualization Configuration tool to configure KPIs from Adaptive Search saved searches or from OTBI
analyses.Create the Metric Card for the Top of the Tab.

You can also create KPIs by entering a query in the sales dashboard Ask Oracle bar. See the topic: Create a Chart or a KPI
from a Prompt. The Al agent creates simple KPIs that don't include badges, secondary metrics, or descriptions. You can
add these in the Visualization Configuration tool.

KPIs Appear as Tabs in the Sales Dashboard

Here's a screenshot of a sample dashboard with 2 tabs. The screenshot highlights the part the tabs defined by metric
cards.

12
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Sales Dashboard
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Charts

Interactive charts help salespeople identify patterns, track progress, and communicate performance clearly. Using
charts, salespeople can visualize sales data trends and distributions, such as pipeline by stage, revenue by region, or
lead conversion rates, for example. And they can drill down into individual records.

You can choose any of the available chart types including bar, pie, donut, funnel, scatter, and combo charts.

Opportunities by Stage

W Quahlfication

B MNegotiation
B Clouing the Desl

Al Insights into the Information in a Chart

From any chart a salesperson can use the Narrative Insights Al agent to generate a description of the key information
underlying the chart and they ask follow-up questions.

For details see the topic Al Agents in the Sales Dashboard.

ORACLE
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What Tools to Use to Create Charts

There are several tools available for sales administrators to create charts for the sales dashboard. Which you should use
depends on the complexity of your use case:

- To create simple charts, you can enter a query in the sales dashboard Ask Oracle bar. The Sales Analyzer agent
does the rest.

The Sales Analyzer agent can create charts from attributes enabled for Adaptive Search and your chart can
group data by 1 attribute. For example, you can have the Sales Analyzer create a bar chart showing the number
of opportunities for each of your team members by sales stage, but you can't generate a stacked chart that
shows the number of opportunities and revenue by sales stage.

- To create more complex charts from Oracle Transactional Business Intelligence (OTBI) analyses, you can use the
Express Reports tool.

Express report charts can group data by several factors. For example, you can group revenue by product and
state. Take advantage of prebuilt visualizations to display the trends and key performance indicators

How to configure and use Express Reports is covered in a separate playbook How do | get started with Express
Reports?.

- Another tool for creating complex charts from both Adaptive Search and OTBI analyses, is the Visualization
Configuration tool. With this tool, you can create charts for both sales dashboards and the CX Sales Mobile app.

Tables

Tables in the sales dashboard present structured sales information, such as opportunities, accounts, or tasks in rows
and columns, making it easy to scan, compare, and drill down into record-level details. Users can take smart actions
directly from tables, to update records and follow up on opportunities, for example.

Hardware Opportunities

Neme & Account % Owner © Amount E':ti" & Actions
Generators for Data Center Pinnacle Technologies %ara Sales Rep £ 124,000 Bridf2a
f or HO Redline Hosting Fusion Admin 2 310,000 Brrasda
Redline Hosting - Hybid. .. Redline Hosting Sara Sales Rep % 185,000 Bf14/24

WView All (4)

What Tools to Use to Create Tables

Use the Visualization Configuration tool to create tables from Adaptive Search saved searches or from OTBI analyses.

For personalization, you can also create a table by entering a query in the sales dashboard Ask Oracle bar and click the
Visualize selection. See the topic: Create a Chart or a KPI from a Prompt.
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Lists

Lists provide a simplified view information, such as “My Open Leads” and “Upcoming Appointments.” They're compact
and easy to navigate, helping sales users stay on top of daily tasks and activities. Like tables, lists support smart actions
directly from the dashboard, allowing quick updates and next steps in context.

My Favorite Opportunities
MNew PowerMax Center

Redline Hosting ~
$262,1428 o
11/30/24

Batteries for Power Center

Heaney Inc ™
$ 19,250 o

What Tools to Use to Create Lists

Use the Visualization Configuration Tool to create lists from Adaptive Search saved searches.

Embedded Oracle Fusion Data Intelligence Components

You can also embed reports from Oracle Fusion Data Intelligence. Fusion Data Intelligence is built on top of Oracle
Analytics Cloud.
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2 Before You Begin

Before You Configure the Sales Dashboard

Before your team can start creating application extensions, you must first set up Oracle Visual Builder Studio. You only
need to set up VB Studio once for every implementation.

Complete VB Studio implementation steps are documented in the Oracle Cloud Administering Visual Builder Studio
guide. See the topic: How Do | Set Up VB Studio?

Required: Set the Extension ID for Sales

When using VB Studio to extend Sales pages, your extension must use the extension ID: site_cxsales Extension. YOU
set this extension ID when you first set up your project.

A project collects all the people, tools, and processes you need to complete a discrete software effort in VB Studio.
Oracle best practice dictates that you use a single project for all the extension work you do within the Oracle Cloud
Application environment family.

You can create this project using one of two methods discussed in the following video: Create the Visual Builder Studio
Project.

Each method requires a different way to set the extension ID:
- Create a project from a Sales page by clicking the Edit Page in Visual Builder Studio link in the Settings and

Actions menu. This is the recommended method to create a project because it automates the creation of key
VB Studio components. See the topic: Create a Simple Extension.

If you choose this method, then you'll update your project's extension ID to site_cxsales Extension by editing
the extension-level settings. See the topic: Establish Extension-Level Settings.

- Create a project from the Organization home page. See the topic: Manually Create a Project for Extensions.

If you choose this method, then you'll enter the required extension ID when you create your own workspace.
See the topic: Create an Extension.

Note: Be sure to publish your extension so that the updated extension ID becomes the default going forward for
everyone else working on the extension.

Tip: Create Additional Workspaces

At some point in your extension lifecycle, you might need to create a new workspace in an existing project. You may
want to create a new workspace from the main branch if you forget what changes a particular workspace contains, for
example. Follow the instructions in the topic: Clone an Existing Repository.

You can also view the following video: Create a Workspace.
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Enable Opportunity Pipeline Attributes in Adaptive
Search

For the Sales Dashboard to display values in the Opportunity Pipeline Amount and Win Probability, a few fields must be
enabled in Adaptive Search. After you enable the fields, you must run the Partial Publish scheduled process to activate

your changes.

Enable the following fields in the Setup > Advanced tab of the Configure Adaptive Search setup task:
Primary Revenue

Navigation: Opportunity > Primary Revenue > Primary Revenue
- Win Probability

Navigation Opportunity > Primary Revenue > Opportunity Revenue > Primary Revenue > Win Probability
- Amount

Navigation: Opportunity > Primary Revenue > Opportunity Revenue > Amount
Here's how to enable the fields:
1. In the Setup and Maintenance work area, open the Configure Adaptive Search task:
o Offering: Sales
o Functional Area: Sales Foundation
o Show: All Tasks
o Task: Configure Adaptive Search

2. Click Setup > Advanced.
3. Onthe Advanced tab, click Primary Revenue.
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4. Inthe Configure: Primary Revenue pane, select the Enable checkbox for the Primary Revenue field.
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¥ Rrvenume o
r Oppormauty Rolug
B Chwresr
B Proary Comgente:
b Premary Contact
¥ Prmary Campaign
¥ Primary Pasines
4 [Primary Reeverss|
5. Click Primary Revenue > Opportunity Revenue.
Cﬂnﬁgure Adaptive Search (@
Monitor Cuick  Advanced
ﬁ# Satup Objects Enabled for Adaptive Search t3 Actions ¥ | Save
I Parameoters P g Configure : Opportunity Revenue
Configurg LA ¥ Oppartundy Campaigns Configure Fialds:
b Oychestration Associations
®  Configure Globa... ¥ Pariners Find Flalda | win probability e it
k Team Members
. _ Display &%
b Revenues
Field N Type Enable
¥ Opportuniy Rollup
¥ Coamor
WinProb Win Probability Parcaniags '

w

L4

Primary Contact

¥

L

Primary Fartres

Primary Competitor
Frimary Campaign

4 Primary Revenus

o; Opportunity Revenus
F Bem

6. Inthe Configure: Opportunity Revenue pane, use the Find Fields field to search and enable the Amount field

and the Win Probability field.
7. Click Save.
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8. Publish the new attributes by running the Partial Publish process:

a. Click Actions > Partial Publish.

b. Select Opportunity.

c. Click Proceed with Partial Publish.

d. Inthe Partial Publish window, click Publish.

Get a Quick Start by Importing Sample OTBI Reports,
Visualizations, and Dashboard

You can import sample Oracle Transactional Business Intelligence (OTBI) reports, their accompanying visualization
configurations, and a sample sales manager dashboard. The OTBI reports cover accounts, activities, forecasts,
leads, opportunities, orchestrations, and quotes. You can edit the content to suit your needs and use it in your own
dashboards.

Importing the sample content and creating the sample dashboard involves 4 steps:

Download .zip files with the sample reports and configurations from Oracle Customer Connect.
Import sample reports into OTBI.

Import the visualization configurations related to the reports into the Visualization Configuration tool.
Import the sample sales dashboard configuration files into Oracle Visual Builder Studio.

PUWUNA

Download .Zip Files from Oracle Customer Connect

While signed in to Oracle Customer Connect, download the following 3 files:

« Step-1.zip

Includes sample reports that you import into the Custom folder in the OTBI Catalog.
« Step-2.zip

Includes visualization configurations for the OTBI reports that you import using Import Management.
- Step-3.zip

Creates a sample Sales Manager dashboard after you import this file into VB Studio.

Import Sample Reports into OTBI

1. Extract the files in the step-1.zip file to your desktop.

2. Open Reports and Analytics (Navigator > Tools > Reports and Analytics).
3. Select Browse Catalog.

4. Open the Shared Folders and select the Custom folder.

Note: Don't select subfolders.

In the Tasks pane, click Unarchive.

. Inthe Unarchive dialog box, browse and select the Oracle Sales Dashboard Content.catalog from the
extracted folder on your desktop.

7. Click OK.

o u
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The Oracle Sales Dashboard Content folder is created in the Custom folder. The new folder includes the
sample reports.

Import the Sample Visualization Configurations

Import the sample visualization configurations that go with the OTBI reports. The reference numbers of the
configurations you import are prefaced with "ORCL_".

1.

3.

4.

Extract the files from the step-2.zip archive.
2. Navigate to Import Management (Navigator > Tools > Import Management).
Import the visualization configurations:

g.
h.

=0 2n CQ

Click Create Import Activity.

In the Create Import Activity page, enter any name for your activity.

In the Object list, enter visualization and select Visualization Configuration.

Click Choose File and select the DataVisualizationConfig_1_1_001.csv file.

Click Next.

On the Map Fields page, click Next as all of the fields are automatically mapped for you.

Note: You can ignore any unmapped field warning messages.

Click Next.
On the Review and Submit page, click Submit.

Import the layout preferences for the visualization configurations:

g.
h.

=0 2n CQ

Click Create Import Activity.

In the Create Import Activity page, enter any name for your activity.

In the Object list, enter Layout and select Layout Preferences for the Visualization Configuration.
Click Choose File and select the BiReportUserPref_1_1_001.csv file.

Click Next.

On the Map Fields page, click Next as all of the fields are automatically mapped for you.

Note: You can ignore any unmapped field warning messages.

Click Next.
On the Review and Submit page, click Submit.

Import the Sample Sales Manager Dashboard into VB Studio

Importing the Step-3.zip file into VB Studio creates a sample custom Sales Manager dashboard that's available to users
with the ORA_ZBS_SALES_MANAGER_JOB and the ORA_ZBS_SALES_ADMINISTRATOR_JOB job roles. Because this
sample dashboard isn't part of the application provided by Oracle, you can edit it at will.

1.

2.
3.

Open the Sales Dashboard in the application and click Settings and Actions > Edit Page in Visual Builder
Studio.

Click the Menu icon (3 dots next to the Publish button at the top of the page) and select Import.

In the Import Resources dialog, upload the Step-3.zip archive and click Import.

If you have one of the two job roles, you can preview the dashboard using the Preview icon (next to the Publish
button at the top of the page).

You can edit the conditions that make the sample dashboard visible, by editing the Metrics Container. The
process is similar to creating a metrics container as described in the topic Create the Shell of Your Dashboard by
Duplicating One of the Dashboards Provided by Oracle.
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6. You can also edit the rest of the sample dashboard contents as described in the rest of this guide.
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5 Al Agents

Al Agents in the Sales Dashboard

Salespeople can use 2 Al agents in the sales dashboard. One creates create charts and tables from prompts. The other
can be used to gain insights on the information presented in charts.

- Sales Analyzer: transforms prompts users enter in the Ask Oracle bar into charts, tables, and KPlIs.
Things to know:

o The Sales Analyzer agent uses the sales information indexed by Adaptive Search.
o Attributes that salespeople use for grouping chart information must be enabled for Group by during
Adaptive Search setup.

o You're limited to grouping the data by one attribute. For example, you can have the Sales Analyzer create
a bar chart showing the number of opportunities for each of your team members by sales stage, but you
can't generate a stacked chart that shows the number of opportunities and revenue by sales stage.

o For salespeople and sales managers, the charts are temporary. They can't be saved unless you have sales
administrator privileges.

o Sales administrators can save the charts in the library and add them to dashboards using the
personalization feature. Or they can edit the generated content in the Visualization Configuration tool
and add it to sales dashboards in Oracle Visual Builder Studio.

For more information on how to use the agent, see the topic Create a Chart or a KPI from a Prompt.

Narrative Insights: generates text insights on sales dashboard visualizations and allows salespeople to ask
follow-up questions about the underlying information:

a. Salespeople click Action > Insights next to a graphic displayed in the sales dashboard.
b. The agent displays the insights in a drawer.
c. Salespeople can follow up with questions in the drawer.

The Narrative Insights agent is a supervisor agent that orchestrates the generation of narrative insights by
managing the flow between data retrieval and analytical processing. It classifies user queries, decides whether
visualization data is sufficient, and delegates tasks to the appropriate agents to produce fact-based, context-
aware insights.

For more information on how salespeople use the agent, see the topic Generate Insights from Sales Dashboard
Graphs in the Using Sales for Redwood guide.

Enable the Sales Dashboard Al Agents

Enabling the Sales Analyzer and Narrative Insights agents in the Sales Dashboard involves 2 steps:

1. You copy the agents Oracle provides in Al Agent Studio.
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2. You open Oracle Visual Builder Studio and enter the agent team codes of the copies in the enableAgents

constant.

Copy Both Agents Provided by Oracle in Al Agent Studio

Copy both the Sales Analyzer and Narrative Insights agents provided by Oracle in Al Agent Studio and make a note of
the Agent Team Code for each.

PUWUNa

@O Now

Open Al Agent Studio (Navigator > Tools > Al Agent Studio).

Search for the agent by name (Sales Analyzer or Narrative Insights).

Click Copy Template on the agent.

In the Copy Template dialog, enter a suffix that will be added to the agent name. For example: v1.

Your new agent opens for editing.

In the agent edit page, click Publish.

On the navigation bar at the bottom of the page, click Agent Teams.

On the Agent Teams page, search for the agent by name.

Make a note of the Agent Team Code for each agent. (for example: SALES_ANALYZER_V1and
NARRATIVE_INSIGHTS_V1). You need the codes to reference the agents in VB Studio.

Enter the Agent Team Codes in VB Studio

Enable the agents using VB Studio:

1.

5.

Navigate to the Sales Dashboard and open VB Studio. (Settings and Actions > Edit Page in Visual Builder
Studio).

On the sales-dashboard tab, click the Variables subtab.

Under the Constants heading, click the enableAgents constant.

In the Properties tab, Default Value box, enter the following code, replacing the agent team

codes in this example with your own: [{"sales Analyzer":"SALES ANALYZER V1"},{"Sales
Insights":"NARRATIVE INSIGHTS V1"}]

Getting Started [y sales-dashboard x o

Page Desigrer Action Chains Evenit Listerers Events Types Vasiatiles (18] I aSerigt 1508 Settings
- Constant _;,5'
3 Fike W 4= Constant <+ Variable %
[L:] o
F]

~ Constants Extensson Ruad, Override [ enableAgents | Sales

Descripbion
E= allowPersonalization | Sales | &
Enable A Apents on your deshboand by speclying spent names
B cortentStyle | Sales | @ and their Weekdlow Code or Agent Team Code, Example: | “Sales
Anahreer™; "SALES_AGENT_TEAM_V1" | { “Sales Inmighis™

¥ [} dashboardFeatures | Sales | @ "MARRATIVE_IMSIGHTS_ V1" }

Detault Value
A delaultMetricCaed | Sales | S fxix

(" Sales Analyzer™"SALES AMALYZER_V1%).["Sales
Ex cynamecDashboard | Sales @ Ingsghis™, " MARRATIVE INSIGHTS_V1ITH

¢ [] crabledgents | Sale @ a

3 [3 erablefders  Sales @
Override is active

E= enablelnmghts | Salss | @ e

E= erableSearch | Ssles  ® Mo wiages fourd in this extenson

Test and publish.
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4 Create Content Using the Visualization
Configuration Tool

Visualization Configuration Tool Overview

The Visualization Configuration tool enables sales administrators to create and manage the visualizations displayed on
sales dashboards and the CX Sales Mobile app. Using this tool, administrators can convert data from Adaptive Search
saved searches and Oracle Transactional Business Intelligence (OTBI) analyses into interactive visual components.

With the Visualization Configuration tool, administrators can design dashboards that not only present sales data clearly
but also allow users to act on the data using drill-downs, filters, and smart actions.

A wide range of visualization types is available, including:

- Tabular view (tables)
List view
Bar chart
Pie chart
Line chart
Donut chart

- Combo chart
Key Performance Indicator (KPI) cards
Meter gauges
Bubble chart
Funnel chart

- Areachart

Pivot chart

Each visualization type serves different purposes, such as comparing data across categories, visualizing trends over
time, or highlighting key performance metrics.

After creation, visualizations are stored in a central library and can be added to sales dashboards as needed. Sales
administrators can access the Visualization Configuration tool directly from Application Composer, without the need to
activate a sandbox.

Table and Chart Visualizations at Runtime

Here's how tables and charts created as visualizations display to users.
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Table Visualizations

A table visualization displays records sorted by how often they've been accessed. The most frequently accessed
appear first. You can enable drill-downs to individual records and you can add the Actions list. With the smart actions,
salespeople can create tasks, schedule appointments, send emails, and make calls directly from the table, for example.

My Team's Opportunities
Mame 2 Account 2 Owner 2 o] : = Amount 2 Actions
R b b Probability ™ e
Generators for HO o Redline Hosting Fusion Admin  40% $ 310,000
Batteries for Power... Heaney Inc Fusion Admin  20% % 19250
Mew PowerMax Ce... Redline Hosting Jane Solis 10% $ 2621428
View All (8) o

Tables include a View All link (callout 2 in the screenshot) that opens a list page showing all records matching the
visualization selection criteria.

My Team's Opportunities Actions v || Craste Opportusty
o Satus Open X Recond Set My subordirates sreon thetsam 3 Try seanching Dy kéywoid o add a add Filu
R TE———

8 Results Group By | Nome -
0O wis.. 2 Mame O Accoam O Armsbiant 3 Clese Date ~
O A0% et Bagen Ratke and Deayle $ 300,000 851725
O 10%  Mew Powerbdax Center Rediing Hosting $ 2621428 3225
(] T Hybrid Generator - Redline Hosting Redline Hosting % 1,080,000 319425
0 0% Redling Hoazing - Mybrid Genarabor: Rl MO STNg % 185,000 1905
O A0 ale Linggard @ Hegrnann Limited Hegmann Limited § 10,050,000 215

Chart Visualizations

Salespeople can click a section of a chart to view the underlying records.
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Drill-downs in visualizations from OTBI analyses open on a page showing both the visualization and the list. Drill-down
from Adaptive Search visualizations open up a list page for that object.
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Adaptive Search saved search visualizations open a list page.
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Metric Cards

You can also use the Visualization Configuration tool to speed up the creation of the sales information that appears
at the top of each tab in the sales dashboard. Metric Card visualizations provide a Ul where you can specify all of the
information you can display, including the title, KPI, and badges.

Deal Registrations | HIGH

$189.12K (22)
Deals by Partner Track

Because Metric Cards are used for configuring the sales dashboard tabs, their creation is covered in the Configure the
Redwood Sales Dashboard chapter topic Create the Metric Card for the Top of the Tab.

Create Visualizations

Using the Visualization Configuration tool, you can create visualizations from two types of sources of sales data:
Adaptive Search saved searches and Oracle Transactional Business Intelligence (OTBI) analyses. Each type requires
slightly different steps to create so the steps are covered in different sections:

- For Adaptive Search saved searches, see the section Create Visualizations from Saved Searches.

Tip: You can get a head start on creating visualizations from Adaptive Search by having an Al Agent create
basic charts, KPIs, and tables for you. Use Al to Get a Head Start by Creating Charts and KPIs from a Prompt

- For OTBI analyses, see the section Create Visualizations from OTBI Analyses.
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Prerequisites

To create visualizations using the Visualization Configuration tool, you must have the privilege
ZCA_MANAGE_DATA_VISUALIZATION_CONFIGURATION_PRIV.

Setup users with one of the following job roles provided by Oracle already have this privilege:
« ORA_ZCA_CUSTOMER_RELATIONSHIP_MANAGEMENT_APPLICATION_ADMINISTRATOR_JOB (Customer
Relationship Management Administrator)
- ORA_ZBS_SALES_ADMINISTRATOR_JOB (Sales Administrator)

Create Visualizations from Saved Searches

The recommended method for creating a visualization from Adaptive Search is to create the visualization from the
default saved search.

The visualization inherits the filters from the default saved search and lets you edit them. This method:
Makes it unnecessary to create and manage individual saved searches for each visualization.

Makes it easier for you to migrate the visualizations to other environments.

You can use Al to assist you in creating the visualizations. See the topic Use Al to Get a Head Start by Creating Charts
and KPIs from a Prompt.

The steps for creating charts and tables are slightly different, so they're covered in separate topics:

« Create a Chart from the Default Saved Search
« Create a Table from the Default Saved Search

Use Al to Get a Head Start by Creating Charts and KPIs from a
Prompt

Get a head start on creating visualizations by having an Al Agent create basic charts, KPIs (metric cards), and tables
for you. You enter a prompt in the sales dashboard, and the Al agent does the rest. If you have sales administrator
privileges, you can save and edit the resulting content in the Visualization Configuration tool and add it to sales
dashboards in Oracle Visual Builder Studio.

1. Enter a prompt in the sales dashboard Ask Oracle bar:
o To create a chart, enter a prompt and prefaced with the verb "show".

For example, enter: show lost opportunities by sales stage for the Standard Sales Process sales
method . In your prompts, be as specific as possible for better results.

o To create a KPI, enter a prompt starting with "sum of" or "number of". For example, enter: number of
opportunities closed this quarter.

The prompt you enter becomes the title of the KPI.
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2. When you see the Visualize selection in the list, click it or press the Shift and Return keys on your keyboard.

Sales Dashboard

show lost apportunities by sales stage for the Standard Sales Process sales methad|

Mo results found.

Ct Visualize show lost opportunities by sales stage for the Standard Sales Qe
Process sales method

Depending on your prompt, the agent generates a chart, a KPI (metric card), or a table and displays it in the
drawer.
3. If you aren't satisfied with the result, rephrase your prompt and try again. Direct editing is limited:
o For charts, you can update the dimensions and metrics of the visualization by clicking the Action (3
vertical dots) icon. Depending on the graph type, you can change:

- The attribute on the x-axis
- The attribute that's used to categorize the data
- Graph orientation

- Graph stacking
o You can't edit the generated KPIs directly in the drawer. You must use the Visualization Configuration

tool.
4. If you have sales administrator privileges, then you can save the generated content to the library by clicking

Add to Library.
Once saved, you can:
o Add the content to your personal sales dashboard by clicking Edit Page Layout button.
o Edit the content in the Visualization Configuration tool and add it to sales dashboards using Oracle Visual
Builder Studio.

Create a Chart from the Default Saved Search

You can save time when you select Default as your saved search in the Create Configuration page. That's because
selecting the default saved search as your source, makes it possible for you to change the filters directly in the
Visualization Configuration tool. Entering filters directly, eliminates the need for you to create and manage a specific
saved search for each visualization.

The visualization you create is based on the default saved search for the object that's shared with the sales organization
as a whole.

Tip: You can have Al help you with the initial chart creation and use these steps to refine the results.

Navigate to Configuration > Application Composer.

Click Visualization Configuration in the right-hand pane.

In the Visualization Configurations page, click Add.

From the Create Configuration page, Source Type field, select the Adaptive Search.

PUNa
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5. Select the object.
6. Leave the Saved Search field set to Default. This selection specifies to use the default saved search for the
object.
7. Inthe Visualization Type field, choose the visualization type, such as a bar chart, pie chart, donut chart, combo
chart, metric card (KPI) and so on.
8. Inthe Details section, enter the dimensions and other preferences for the visualization. Which attributes are
available depends on the type of visualization you're creating.

Note: Only attributes that have been enabled for Group By in Adaptive Search are available for selection as
your chart axes. For details, see the topic How do | enable the filtering of visualizations by team members?

. The Filter bar initially displays the filters in the default saved search. You can update or delete these filters and

9
add your own filters.
Filters
= Status Open b4 Record St My subordinates ani on the téam W Add Filter Add Filter
Drill Down @ |

You can make it possible for salespeople to specify filter values in the chart for a maximum of 2 filters:

a. Click the filter.
b. Select the Prompted option.

~ Filters
= Status Open Close Date Between Today -< MNext 30 Days .  Add Filter
: Val
~ Drill e
Open (3)
& Prompted (2/2)
= Advanced Filter

Note: Only filters that source data from a list of values or lookups can be marked as prompted.
10. Enable salespeople to drill down to the list page by turning on Drill Down.

When salespeople click one of the sections of the chart, the application displays a drill down page with a list of
the records in that section. The columns are provided by the default saved search.

11. The Settings section lets you change the orientation of chart, stacking, and the inclusion of a grand total.
You can also specify the data label position, along with Grand Total for both Adaptive Search and OTBI based
visualizations
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12. Set the Status field to Active.
13. Click Create to save the configuration.

14. Note the number of the visualization configuration on the list page. You'll use the number to include the

visualization in the Sales Dashboard.

Entries for a Sample Revenue Bar Chart Visualization Created from

Adaptive Search

Here are the entries to create a sample bar chart visualization from Adaptive Search. The chart shows the revenue by
opportunity team member for the last year, this year, last quarter, and this quarter.

Revenue by Team Member

Clicking on last year's section for one of the team members opens a list page with the team member and last year's

filters added. The list page includes the title of the visualization.

ORACLE
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W Thes Year
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hirgg by keywesrd oo add a f Actel W iBer
24 Rl Cargup By MO =
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Here are sample entries to create the chart:
Field Name Entry Description
Source Type Adaptive Search Visualization source.
Object Opportunities Business object

Saved Search

Name

Visualization Type

X Axis

Categorized By

Value

Format

Unit
Aggregation
Orientation

Stacked Layout

Filters

ORACLE

Default

Revenue by Team Member

Bar Chart

Owner

Close Date

Primary Revenue Amount

Currency

Round Even
Sum
Vertical

On

Status: Open, Record Set: My subordinates are
on the team

The visualization uses the default saved search
as the source of your information and lets you
change the filters.

The title of your visualization and the drill down
page.

Different visualizations require different
attributes.

Displays owner names along the x-axis

The quarter in which the close date appears.
Because Stacked Layout is selected, the
quarters appear as sections of each owner's
bar.

Opportunity revenue

Supplies currency symbol. Click the Preferences
button to see this option.

Rounding.

Type of calculation.

Bar chart orientation.

Displays the different quarters as sections on a
bar. If off, you get separate bars for each time

period for each team member.

Filters come from the default saved search, but
you can change them.
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Field Name Entry Description

You can mark up to 2 filters as prompted. Only
filters that source data from a list of values or
lookups can be marked as prompted.

Drill Down On Enables drill-down.

Create a Table from the Default Saved Search

Here's how to create a table when you select Default as your saved search. Making this selection makes it possible for
you to add the filters in the visualization itself.

1. Navigate to Configuration > Application Composer.

2. C(Click Visualization Configuration in the right-hand pane.

3. Inthe Visualization Configurations page, click Add.

4. From the Create Configuration page, Source Type field, select the Adaptive Search.

5. Select the object.

6. Leave the Saved Search field set to Default.

7. In the Visualization Type field, select Tabular Chart.

8. Inthe Columns section, use the Add Column list to add the columns you'd like to display in the table. The table
builds as you add columns.

Visualization Type -
Tabular Chart
Columns

Add Column -
— Mame x
R s iy o4
Primany Re & Expected Rewve x

Actions B

9. Turn on Actions to display the Actions list (three dot icon) on each record in the table.
10. Click the column name link to format the columns in the table and to specify the drill down destination:
a. Inthe Preferences drawer Format field, add any required format for the column. For example, to add the
currency symbol, select Currency.
b. Click Drill Down to enable drill down from the column.
c. Select the page you want to open. For example, to open the opportunity details page, select
opportunities.
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Preferences ®
Columns -
Mame
Format -
Text

Drrill Down [ @)

Page - ‘

opportunities

d. Click Back.
11. In the Filter field, specify the filters for the table. The field initially displays the filters in the default saved
search, but you can update, delete, and add filters.

Filters

= Status Open 2  Add Filter Add Filter

12. In the Drill Down section, use the controls to specify which columns you want to display in the list page that
opens when users click the View All link at the bottom of the table.

Initially, the application lists the columns provided by the default saved search.

ORACLE
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13. You can display the Actions menu on each record in the list by switching on Actions.

Drill Down

Add Column -
= Account x

=  Chose Date »
= HName >

— Orameer x

= Primary Revenue: Amount h 4

= Primary Revenue: Win Probability 4

= Sales Stage >

Actions [ B

14. Set the Status field to Active.

15. Click Create to save the configuration.

16. Note the number of the visualization configuration on the list page. You'll use the number to include the
visualization in the Sales Dashboard.

Create Visualizations from OTBI Analyses

Using the Visualization Configuration tool in Application Composer, you can create interactive charts and tables for your

sales dashboard from Oracle Transactional Business Intelligence (OTBI) analyses. Salespeople remain in the Redwood

User Experience when they drill down on charts or tables. They can drill down to individual records and take advantage

of smart actions, such as making a call by clicking a phone number.

The steps to create a chart or a table use the same Ul, but are slightly different, so they're covered in separate topics:
Create a Table from an OTBI Analysis

Create a Chart from an OTBI Analysis

What to Check in OTBI Before You Start

Make sure that the person creating the visualization can view data in the analysis itself. You can temporarily
remove filters from your analysis to ensure that you see data as you create the visualization.

- You can source multiple visualizations from the same OTBI report. It's good practice to have the smallest
number of columns in the report that you need for those visualizations.
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If you plan to enable drill-down from a table on the sales dashboard, then you must also add the ID and PUID
columns that can uniquely identify each individual record to your analysis.

For example, to enable drill down on opportunity name, you include the Opportunity Number (the PUID) and
the Opportunity ID columns. For leads, it's the Lead Number and Lead ID, and for activities, it's the Activity
Number and Activity ID. For accounts, it's the Account Number (Registry ID in the OTBI Subject Area) and
Account ID ( Customer ROW ID in the OTBI Subject Area).

- You must ensure that none of the columns you selected as criteria in your OTBI analysis are marked as hidden

in the report. All of the columns, including the ID and PUID must be visible in the results.

It's a good idea to store your analysis in the Custom folder.

Create a Table from an OTBI Analysis

Here's how to create a table for the sales dashboard from an OTBI analysis using the Visualization Configuration feature
in Application Composer.

Create the Visualization

VAWNRA

o

10.

Navigate to Configuration > Application Composer.

Click Visualization Configuration in the right-hand pane.

Click Add to create a new configuration.

On the Create Configuration page, select OTBI Analysis as the Source Type.
Click Select Catalog Folder, the folder icon, and select Custom.

Create Configuration

= -] - Wy 4 TENETTENE L TR = - | R A

- 5 ; _ -

OTEBI Analysis

Custom

Subscription Management

In the search field, enter the name of your custom analysis.

Select the analysis in the search results. All the fields in the analysis are included automatically, and the
visualization displays on the page.

In the Name field, enter the title for the table.

In the Visualization Type field, select Tabular Chart.

Use the controls in the Columns section to change column order and to hide columns you don't want to display
in the table.
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Callout Control Description
1 Use the handles to change column order.
2 Click the name link to specify column format (such as currency, decimal, or percentage) and

enable drill-down on the field.

3 Hide columns in the table. In this example, we're hiding the Opportunity ID and Opportunity
Number columns. These columns are used to identify the record for the drill down in the next
step. They aren't meaningful to salespeople.

Source Type ﬁ Search for snalysis in /...

OTEI Analysis T Opportunity Sales Stage |
Mams Status

Opportunity Sales Stage Detail Draft -

Visualization Type
Tabular Chart

-— Expesgted Clote Date

== ¥ of Days in Cunrend Stage

== Duays Stalled

= Avverage Duration of Stage

- Enferpriie Ohwssrber

= Opportunity ID

- Opportunity Number

¥ ¥ © @ @ ® e @
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Enable drill-down functionality on fields in the table. For example, open an opportunity by clicking on its name:

n.

12.
13.
14.
15.

a. Click the Name link.
b. On the Preferences drawer, turn on Drill Down.
c. Inthe Page field, select the type of record you're opening. In this example, opportunities.
d. Inthe PUID field, select the number ID for the object. For opportunities this is the Opportunity Number.
e. Inthe ID field, select the object ID field, such as Opportunity ID.
Preferences *
ooy -
Farmat
Text v
Drill Down .:l
Page
opportunities T
PLRD o
Oppartunity Mur Opportunity ID
f. Click Back.

You can test the drill-down from the table.

Set the configuration Status to Active.

Click Create to save the configuration.

Note the number of the visualization configuration on the list page. You use this number to reference the
visualization in the sales dashboard.

Create a Chart from an OTBI Analysis

Follow these steps to create various kinds of charts from Oracle Transactional Business Intelligence (OTBI) analyses.

1

cupuUuN

Make sure that the person creating the visualization can view data in OTBI itself. You can temporarily remove
filters from your analysis to ensure you see data as you create the visualization.

Navigate to Configuration > Application Composer.

Click Visualization Configuration.

Click Add to create a new configuration.

On the Create Configuration page, select OTBI Analysis as the Source Type.

Click Select Catalog Folder, the folder icon, and select Custom.

ORACLE
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7. Inthe search field, enter the name of your custom analysis.
8. Select the analysis from the search results. All the fields in the analysis are included automatically.
9. In the Visualization Type field, select the chart type.

10. Inthe Name field, enter the display title of the chart.

11. In the Details section, choose the columns of the report for the chart type you selected. Different types of
visualization require you to enter different parameters.

12. The Settings section lets you change the orientation of chart, stacking, and the inclusion of a grand total.
You can also specify the data label position, along with Grand Total for both Adaptive Search and OTBI based
visualizations

13. In the Sort section, you can sort the chart data using any of the attributes in your analysis.

14. Optionally, add a filter that salespeople can use to narrow down the scope of the visualization. The filter
appears above the chart.

Souree Type P
OTEI Analysis Sahared fCustom /COM oY Acco Yo¥Y Account SPEHﬂ bV
.

Mame Tt - Orverall Yesrly Spend: 5,844, 875
Yo¥ Account Spend by Category Dirafy P

Applications T
Bar Chart -

w Details

o A - Cateporized By
fear Category

Yearly Spend

w Settings

Dirbpntation

T ogs ‘ I W Apphcationi

@ Vertical (O Horizontal

Diaia Labed

Auto Tir
» Sorting
w Filter

E’.la.-[egar-,- T t;;;gmy &
~ Drill Down B

Seanch bor CARpPEt A%

ﬁ' Search fof Larpet ana
o Account Spend

15. Enable drill-down functionality and configure the list page that salespeople see when they click a chart section.
You can use the same analysis or choose a different analysis as the source for the list page. For example, you
can display an analysis with more details than the original.

The target OTBI analysis must have a prompted filter applied on the same column that will be used for drill-
down. For example, if a manager clicks a bar of a chart representing an opportunity owner, then the analysis
you specify in the drill-down attribute must have a prompted filter on Opportunity Owner column in the report.

40
ORACLE



Oracle Fusion Cloud Sales Automation

Chapter 4

How do | configure the Sales Dashboard in the Redwood Create Content Using the Visualization Configuration Tool

User Experience?

Callout Field

1 Drill Down switch

2 Search for target analysis
3 Drag handle

4 Column names

5 Hide

Drill Down "8 o

ﬁ Search lor tanget analysis in fshaned /Custom folder
Sales Mgr Trend Sales Rep Attainment

Columns o

e = RCOUNT[Customer Unigque Mame)

= SalesRep

= Quota

= Artainrmient

© © 0 o of®

= Period

Description

Enables users to click a section of the chart
to view a page listing the records matching
the filters in that section.

Select the analysis you want to open when
users click a section of the chart.

Change the order of columns in the list page
Click to enable drill-down on the list page.

Hide columns on the list page. A maximum
of 15 columns can be selected to display on
the list page.
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16. Enable drill-down on individual columns on the list page, specify their formatting, and the page they open:

a. Click the field name link.
b. On the Preferences drawer, turn on Drill Down.
c. Inthe Page field, select the type of record you're opening. For example, opportunities.
d. Inthe PUID field, select the number ID for the object. For opportunities this is the Opportunity Number.
e. Inthe ID field, select the object ID, such as Opportunity ID.
Preferences *
Coduming
Mame -
Farrmat
Text ¥
Drill Down .:I
Page .
opportunities
PLRD [n]
Opportunity Nur =~ Opportunity 10
f. Click Back.

17. Set the Status field to Active.
18. Click Create to save the configuration.
19. Note the number of the visualization configuration on the list page.

How do | enable the filtering of visualizations by team
members?

To filter data by the different team members in saved searches and their visualizations, you must enable the Team
Members attribute for the Group By feature in Adaptive Search. You can then use the Team Members field to group
data in your search and the resulting visualization. Suppose, for example, that a bar chart in the Sales Dashboard shows
performance for different team members. Enabling the attribute, makes it possible to click one of the bars to view the
performance just for that team member.
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Enable the Group By Feature

1. Click Navigator > My Enterprise > Setup and Maintenance.

2. Inthe Setup and Maintenance work area, open the Configure Adaptive Search task.
o Offering: Sales
o Functional Area: Sales Foundation
o Task: Configure Adaptive Search

On the Configure Adaptive Search page, click the Parameters tab.

Highlight the Enable Group By and click Edit.

In the Warning message, click Yes.

In the Current Value field, change the value from N to Y and click Save and Close.

A

Enable Team Member Fields for Group By

1. Signin as a setup user.
2. Navigate to the Setup and Maintenance work area, and open the Configure Adaptive Search task:
o Offering: Sales
o Functional Area: Sales Foundation
o Show: All Tasks
o Task: Configure Adaptive Search

3. Onthe Configure Adaptive Search page, click the Configure Ul tab.

4. Select the object you want to set up for your Group By in the left pane of the tab and open the object hierarchy
to locate Team Members and Team Member.

Configure Adaptive Search @

e Configurs 18

Satus Bave | Bawe and Close | Cancel

il Parameters o F o ] Configura : Opportunity

T Configura i Configure Fialds

& Conbigars Qloba

Find Fialdn

Enabin

) Display ) tar
. - Fiarld & in U Dhetineg Filber Groups aroup
By
W W

4 Team Merdern

5. Select the Enable for Group By option for both Team Members and Team Member fields.
Note: Ensure that the Display in Ul option is also selected

6. Click Save and Close.
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7. Sign out and then sign in again to see your changes.

How do | update active visualizations?

You can only update visualizations that are in a Draft status. Before you can update a visualization that's Active, you
must first change the status to Inactive and then to Draft.

Here's how:

1. On the Visualization Configuration page, drill down on the Reference Number of the active visualization you
want to update.

2. Change the Status to Inactive and click Update.
Drill down on the reference number again, change the status to Draft, and click Update again.
4. Drill down again to edit.

w
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5 Configure the Dashboard

Create the Shell of Your Dashboard by Duplicating One
of the Dashboards Provided by Oracle

Oracle provides you with 2 sales dashboards: one for sales representatives and the other for sales managers.

The sales manager dashboard includes conditions that make it visible only the 2 sales manager job roles provided by
Oracle. The sales representative dashboard includes no conditions, so it's available to everyone.

Before making changes or creating a new dashboard, make a copy. You can't edit the dashboards provided by Oracle,
even if you're making a minor change.

1. Open the Sales Dashboard in the application and click Settings and Actions > Edit Page in Visual Builder
Studio.

2. Onthe Components pane, search for and click the Metrics Container link in the Dashboard Fragments folder.

Action Chains Event Listeners Events Types Variables (11 JavaScript JSON Settings
o [+ FittoCarwas =  auto x| auto 100% - sabes-dishboard | Sales
Live Design

Components (5200  Constants (5

.

Sales Dashboard = ™ Dashboard Fragment
©  Try searching by keyword ¢ [ cx-search-bar L
r M ox-sri-visualization L]
My To-Dos Pipehne 3 b [N ex-sri-visualization )
2 $1M ¥ ™ cx-search-bar

El Metrics Containes

* [ Contents Container
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3. Inthe Properties pane, click the Rules button.

¢{ Metrics Container Sales Fragments

General Sections (3)

& Metrics Container

Section Rules Editor

Control rules that make it possible to display different
arrangements according to conditions.

2 Rules # Rules |
All Sections "+ Section
My ToDo's Metrics ?
Sales Dashboard Metrics Container »

salpadolg
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Getting Started [ sales-dashboard x

Page Designer  Action Chains

Metrics Container Rules

Extension Rules

Yo haven't delined ary of your own nules

@ yel

+ Rule

Built-in Rules (3

Everit Listeners

Sales Manager Metrics

e

Sales Representative Metrics

Evernts Typed Variables [14) JawaSenipt JS0M

Sales Manager Metrics

Na Descnpion

Conditions ()

W roles Encludes "ORA_JBS_TNSIDE_SALES MAMAGER_J0E=,
"ORA_IES_SALES_MAMNAGER_J08™

Sections Included in Rule

By ToDo's Metrics

Sabes Manager Pipeline Metrics

You are viewing a read-only rule. To modify i, you need 1o
£ Read Only duplicate it first.

Settings

x

Copy of Sales Manager Metrics

Custom

Conditions

i fapplication.user.roles includes ORA_ZBS_INSIDE_SALES MANAGER 108 or
$application.user.roles includes ORA&_ZBS SALES HMAMAGER JOB

CHe e
.

Edit

Your copies appear in the Extension Container section.

When entering the new container name and in other fields, save by clicking Confirm (the check mark icon).

ORACLE
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5. To specify who can view the sales dashboard:

a. Click Edit in the Conditions section of one of the duplicates you made. You can either use the Design
view to construct the condition or enter it in code directly.

You can tailor your sales dashboard to a specific audience by adding any number of conditions. Here are
some code examples:

- To show the dashboard to users with specific job roles, you can add a condition such
as! $application.user.roles.includes ('ORA ZBS INSIDE SALES MANAGER JOB') ||
$application.user.roles.includes ('ORA_ZBS_SALES MANAGER JOB')
- To have the dashboard appear for a single user, you can add a condition such as the following:
Suser.userName=='SALES_ADMIN'
To enter the conditions, you can use either the built-in editor by clicking Design, or click Code to enter
the code directly.

Tip: To make sure the sales dashboard you're working on remains visible to you during setup, you may
want to delete all the conditions. You can add them back before you publish.

6. Container conditions are evaluated in order from the top instance down. So, make sure that the sales
dashboard you're creating is in the correct position in the list, with the least restrictive last. You can move the
copied containers within the Extension Rules section by dragging.

For example, the Sales Manager Metrics dashboard provided by Oracle displays to sales manager roles because
it's the first on the list. All other users see the Sales Representative Metrics dashboard.

7. You're now ready to start creating the metric cards (the tabs on the dashboard) as described in the topic Create
the Metric Card for the Top of the Tab

8. In the Sections Included in Rule section, you can also edit the existing content:

o Delete any of the existing metric cards.

o Change their position by dragging. The position in list of determines the order of the tabs in the sales
dashboard.

Anatomy of the Sales Dashboard Representation as a Metrics Container

Callout Description

1 Sales dashboard title, which displays only during setup.

2 Conditions that specify who sees the sales dashboard.

3 Sections Included in Rule list the tabs in the order they appear in the sales dashboard. You can

drag the sections to change the tab order.
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Callout Description

4 The content listed in Available Sections contains different types of fragments. These include
fragments that you can't add because they can't be used as dashboard tabs.

Copy Sales Representative Metrics o o @

escription

Conditions Edlit

This rule is always applied. o

Sections Included in Rule

© My ToDo's Metrics 0]

®

Sales Representative Fipeline Metrics ]E[

Available Sections

Sales Dashboard Metrics Container o —

‘Sales Manager Pipeline Metrics -

Create the Metric Card for the Top of the Tab

For each tab you want to add or extend, you must create a custom metric card, the top section of a tab which is always
visible. You can't edit or duplicate any of the metric cards provided by Oracle.

To create the metric card for the top of each tab, you:

1. Create the metric card contents as a visualization in the Visualization Configuration tool.
2. Create the metric card using the visualization in Oracle Visual Builder Studio (VB Studio).

Note: You can also create the specifications for your metric cards manually, directly in VB Studio, without creating a
visualization first. Oracle recommends creating a visualization, however, because the Visualization Configuration tool
speeds up the process, reduces complexity, and avoids errors in setup. For the manual steps, see the topic Create a
Metric Card Directly in VB Studio.

Create the Metric Card Contents as a Visualization

1. Navigate to Configuration > Application Composer.
2. C(lick Visualization Configuration in the right-hand pane.
3. Inthe Visualization Configurations page, click Add.
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4. From the Create Configuration page, Source Type field, select the Adaptive Search or OTBI Analysis,
depending on the source of your data.
5. If you selected Adaptive Search as the source type, then:
a. Select the object.
b. Inthe Saved Search field, then select Default or a specific saved search.

Selecting Default uses the default saved search for that object as your starting point and permits you to
change the filters in the Filters region.

Filters

= Status Open X

Record Set My subordinates are on the team X Add Filter Add Filter

Tip: For metric cards that display KPIs from Adaptive Search, you can use Al to create the initial metric card
for you. For details, see Use Al to Get a Head Start by Creating Charts and KPIs from a Prompt.

6. If you selected OTBI Analysis, then search for the analysis by name. By default, the application searches the

Custom folder, but you can change the folder using the Folders button.

In the Visualization Type field, select Metric Card.

In the Name field, enter the title of the tab you're creating.

9. In the Details section, Primary Metric field, select the type of information you want to summarize under the

title. For example, to display opportunity revenue, select Primary Revenue: Amount.

10. Click the Preferences button (broken vertical lines icon).

11. In the Format field, select how you want the data to be represented. For revenue, select Currency to display the
currency symbol.

12. In the Aggregation field, select the calculation type. For revenue, select Sum, for example.

© N

Details

Primary Matric o 9 Secondary Metnc
I

' I
Primary Revenue: Amount v TiT Count

-
- —

Format - Unit
Currency Round Even

Aggregation
Sum

13. Repeat the same entries for any Secondary Metric. The secondary metric is the number which appears in
parentheses next to the primary metric. For opportunity revenue, you may want to display the number of
opportunities by selecting Count, for example.

14. Inthe Badge section, specify the badges and the ranges of values that display them:

For example, you can configure these badges for tasks:
o If fewer than 5 overdue tasks exist, then don't show a badge at all.
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o If 5-10 overdue tasks exist, then show a warning badge.

o If more than 10 overdue tasks exist, then show a critical badge.

The order of the conditions is important. Each condition is evaluated in the order in which you define them,
from top to bottom. Whichever condition is satisfied first is the condition that's applied.

a. Inthe Badge Type field, select Static.
b. Add the thresholds. For each threshold, specify the badge color, operator, threshold value and short text.

Badge

Badge Type
Static

—+ Add Threshold

Dperstor - Thieihald Value Tt m
Less than equal to 10,000,000 Low

Dperstor - Threthodd Value Text E
Greater than 10,000,000 On Target

15. Set the Status field to Active.
16. Click Create to save the configuration.
17. Note the number of the visualization configuration on the list page.

Create the Metric Card with the Visualization

1. Click the Add Section button in the Metrics Container Properties section.

€ Metrics Container | Sales Fragments

Shijandong

General  Sections (3

= Metrics Container

Section Rules Editor

4 Rules & & Rules
All Sections + Section
My ToDo's Metrics )
Sales Dashboard Metrics Container >
Sales Manager Pipeline Metrics >
Sales Representative Pipeline Metrics >

ORACLE
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2. Click New Section at the top of the list.

Note: Although VB Studio allows it, you can't duplicate the metric cards provided by Oracle. You must create
your own by adding a new section.

3. Inthe Properties, enter a title that's visible only during setup. For example, enter Hardware Pipeline. The title
you enter here isn't the tab title that appears on the sales dashboard page. The runtime title comes from the

visualization you created.
4. C(lick the Go to Designer link.

£ Mew Section E?
i

[[+] E

section

Tithe

Hardware Pypehine

Descripthon
Label Hint

Access for Application Extensions
Disabled Enabled |

App extensions will be able to reference this
template.

Goto JSON

5. Click Code.

Live Design Code

6. Your new Hardware Pipeline section displays empty placeholder template tags. For example:

<template id="salesManagerHardwarePipelineMetrics">
</template>

7. Onthe Components palette, in the Filter field, enter cx-srt-visualization.
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8. Drag and drop the cx-srt-visualization fragment to the editor, between the template tags.

Page Designer Artion Chaing Event Listeners Events Types Variables JavaScript J50N Settings
] 1 ex-srt-visualization b4 === { Return to page

&

g 114 {/0]-vb-Tragment>

E ~  Fragments ® 116 </ template>

g m

cx-sri-visualization

mponent Exchange

Search Exchange 121

Ly Filte

Ds

9. Addthe following class information class="oj-flex oracle-cx-fragmentsUI-cx-fragment-full-height" tO the
<oj-vb-fragment line before the > tag.

<oj-vb-fragment bridge="[[vbBridge]]" name="oracle_cx_ fragmentsUI:.cx-visualization"
class="oj-flex oracle-cx-fragmentsUI-cx-fragment-full-height">

10. Below the bridge parameter and before the </o0j-vb-fragment> tag, add the following fragment parameter.
Enter the number of the visualization you created in the value parameter.

<oj-vb-fragment-param name="reportNumber" value="6001"></oj-vb-fragment-param>

11.  Add the following parameters:
<oj-vb-fragment-param name="context"
value='{"mode": "dashboard", "source":"DV", "slot": "metric"}'></oj-vb-fragment-param>
<oj-vb-fragment-param name="filter" value="[[ $base.page.variables.dashboardFilters ]]"></oj-vb-
fragment-param>
</oj-vb-fragment>

Your finished code will look like this:

<template id="hardwarePipeline'">
<oj-vb-fragment bridge="[[vbBridge]]" name="oracle cx fragmentsUI:cx-visualization"
class="oj-flex oracle-cx-fragmentsUI-cx-fragment-full-height">
<oj-vb-fragment-param name="reportNumber" value="6001"></oj-vb-fragment-param>
<oj-vb-fragment-param name="context"
value='{"mode": "dashboard",b "source":"DV", "slot": "metric"}'></oj-vb-fragment-param>
<oj-vb-fragment-param name="filter" value="[[ $base.page.variables.dashboardFilters ]]"></oj-vb-
fragment-param>
</oj-vb-fragment>
</template>

12. You can preview your changes by clicking the Preview button.
13. Click Return to Page.

You're now ready to configure the content container for the tab as described in the topic Create the Contents Container
and Link It to the Metric Card.
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Create the Contents Container and Link It to the Metric
Card

After you've created a custom metric card for your dashboard tab, you're ready to create the container that will hold the
content you want to display. Here's how.

1. Open the Sales Dashboard and edit the page in Oracle Visual Builder Studio.
2. Onthe Components pane, click Contents Container.

DashboardLayout [} sales-dashboard =

Design Code sales-dashboard = ©X Sales

sajpradolg

Components (4]  Conslants (7
Q Eilter

e ﬁ Dashboard Fraamzn!
™ cx-search-bar

E Metrics Containes

[E' Comtents Contalner I
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3. Click the Rules button.

{ Contents Container Sales Fragments

s sdolg

General  Sections (14)

¥ Contents Container

Section Rules Editor

Controd rules that make it possible 10 deplay different
arrangements sccording to conditions.

4 Rules [g Rules

All Sections + Section |

Deals At Risk Saved Search Table »

Lead Amounts By Team Member Chart »

My Appointments Saved Search List »

My Favorite Opportunities Saved Search List >

My List »
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4. Oracle provides a contents container for each metric card, so select the one that includes content of interest

and click Duplicate.

In this example, we're creating a tab that displays information on the team hardware opportunity pipeline, so
we'll duplicate the Sales Manager - Pipeline Content.

Contents Container Rules

Extension Rules
You haven't defined amy of your own rules
& wer

+ Rule

Built-in Rules

Sales Manager - My ToDwo's Content

Sales Manager - Pipeline Content
Sales Representative - My ToDwo's Content

Sales Representative - Pipelne Content

Sales Manager - Pipeline Content

Conditions

i Svariables.selectedipiTab == salesManagerPipelineMetrics
and
roles includes "0RA_ZBS INSIDE_SALES MANAGER 08,
"ORA_TES SALES MAMAGER_JOB"

Sections Included in Rule

My Team's Opportunities Saved Search Table

My Favorite Opportunities Saved Search List

My Team's Open Leads Saved Search List

Lead Amounts By Team Member Chart

5. Edit the name and click Confirm (the check mark) to save. For example, you can add (copy) to the name. The
name doesn't show up for users, only during configuration.

In the Condition section, click Edit and replace the ID with the ID for the metric card you created.

This link ensures the contents of your tab displays each time a user clicks on the metric card.
You're now ready to create the sections for inclusion in the contents container as described in the topic Create the

Sections with the Content You're Displaying.

Create the Sections with the Content You're Displaying

Create the sections with the visualizations and tables that you want to add to the tab. You can add up to 5 sections in
a tab. Each section can display a table, a list, or a visualization created in the Visualizations Configurations tool or in

Express Reports.

1. Display the Sales Dashboard and open the Oracle Visual Builder Studio.
2. In the Properties pane Components tab, search for and click Contents Container.

ORACLE

Note: Embedding Oracle Fusion Data Intelligence content requires extra steps, and is covered in a separate topic
Embed Content Created in Oracle Fusion Data Intelligence.
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3. On the Contents Container Properties pane, click the + Section button.

¢ Conteénts Container  Sales Fragments

sapsadoay

General  Sections [14)

5 Contents Container

Section Rules Editor

Condrod rules. that make if possible 1o deplay diferent

arrangements acooeding fo condiions

& Rules & Rules

Al Sections 4+ Section

Deals At Risk Saved Search Table H

Lead Amounts By Team Member Chart bl

My Appointments Saved Search List 3

My Favorite Opportunities Saved Search List 3

4. Select + New Section at the top of the list.
5. Inthe Properties New Section pane, Title field, enter a title for the visualization component.

Note: The title is the name of the component and doesn't appear on the dashboard at runtime. The runtime
title comes from the dashboardritle parameter that you add to the visualization code.

6. Click the Go to Designer link.

£ Mew Section '-?
1] E
sections

Title

My Open Opportunities by Stage |

Descripthon
Label Hint

Access for Application Extenslons
Disabled Enabled |

{ App extensions will be able to reference this template.

Go to JSOM
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7. Click the Code button.

Live Design Code

Your new section displays empty placeholder temp1ate tags.

¢ Return to page Live | Design @ Code
T15 [ LFO]-VE-Tragment> =
116  </template> p—

118 <template  id="hardwarePipelineVisualization">
119 </template>

|

128
121 ———
122 ——

8. Add the appropriate code, depending on the type of content you're adding:
o Add Code for Visualizations

o Add Code to Display a Saved Search as a List
o Add Code to Display My List

9. You're now ready to add the section to the contents container as described in the topic Add the Sections to the
Tab's Contents Container.

Add Code for Visualizations

Here's the code that you add between the empty template tags for a section displaying visualizations created using the
Visualization Configurations tool or those created using Express Reports.

< Return to page Live | Design Code
IIS | </0)-VB-Tragments R |
116  </template> —
117 _—
118 <template-id="hardwarePipelineVisualization">

119 </template> —
128

121 m—
122 ——

1. On the Components palette, Filter field, enter cx-srt-visualization.
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2. Dragand drop the cx-srt-visualization fragment to the editor, between the template tags.

3.

Page Designer Artion Chaing Event Listeners Events WS Variables JavaSoript J50N Settings
] 1 ex-srt-visualization b4 === { Return to page

&

E‘ 115 /0 v aE T

E. = Fragments ® ¢ ftemolates

S mn

cx-sri-visualization

Wou can aleo try seanchang for “ex-sn e - o
- visualization™ at Component Exchange €07 o ragment brldgeés= | | VOErl1O0ge ame= Orac i

Search Exchange 121

Ly Filte

Dats

Add the following class information class="oj-flex oracle-cx-fragmentsUI-cx-fragment-full-height" tO the
<oj-vb-fragment line before the > tag.

<oj-vb-fragment bridge="[[vbBridge]]" name="oracle_cx_ fragmentsUI:.cx-visualization"
class="oj-flex oracle-cx-fragmentsUI-cx-fragment-full-height">

Add the following fragment parameters to the code below the bridge parameter and before the </oj-vb-
fragment> tag.

<oj-vb-fragment-param name="reportNumber" value="XXXX"></oj-vb-fragment-param>
<oj-vb-fragment-param name="context" value='{"mode":

"dashboard", "source":"DV", "dashboardTitle": "XXXXX"}'></oj-vb-fragment-param>
<oj-vb-fragment-param name="filter" value="[[ $base.page.variables.dashboardFilters ]]"></oj-vb-

fragment-param>

In your fragment code, replace the values for the reportNumber, source, and dashboardritle parameters with the
values for your custom visualization.

This table describes the key parameters:

Custom Visualization Parameters

Parameter Name Description

reportNumber Enter the reference number of the visualization that you created using the Visualization
Configuration tool.

You can also display the visualizations created in Express Reports, by entering its report
number. The sales dashboard only displays the visualization part of the Express Report. The
table isn't displayed.

mode This value should always be dashboard.

source Enter DV for visualizations you created using the Visualization Configuration tool.

To display the visualizations created in Express Reports, enter SRT.
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Parameter Name Description

dashboardTitle Specify the title of the visualization that displays above the chart at runtime.

Here's a finished code sample for a visualization created in the Visualization Configuration tool:

<template id="hardwarePipelineVisualization">
<oj-vb-fragment bridge="[[vbBridge]]" name="oracle cx fragmentsUI:cx-visualization"
class="oj-flex oracle-cx-fragmentsUI-cx-fragment-full-height">
<oj-vb-fragment-param name="reportNumber" value="4001"></oj-vb-fragment-param>
<oj-vb-fragment-param name="context"
value='{"mode": "dashboard", "source":"DV", "dashboardTitle":"Opportunities by Stage"}'></oj-vb-

fragment-param>

<oj-vb-fragment-param name="filter" value="[[ $base.page.variables.dashboardFilters ]]"></oj-vb-
fragment-param>

</oj-vb-fragment>

</template>

5. You're now ready to add the section to the contents container.

Add Code to Display a Saved Search as a List

You can display saved searches as lists in the Sales Dashboard. Here's how.

Note: The sample code in this example is for opportunities. For value to use with other objects, see the topic Values
to Use in Code for Standard Components in Tables, Metric Cards, and List Views.

1. On the Components palette, in the Filter field, enter cx-panel.
2. Dragand drop the cx-panel fragment to the template editor, between the template tags.

; Getting Started '.!f_] Opporiunities ] product-catalog £ products f"_h._'l sales-dashboard-page-te
2 Page Deslgner Action Chains Event Listeners Events Type Variables (% lavaScript JS0M Settings
= 8 QL e - pan] x ] EEE { Return bo page
g
a8 128
s} = *  Fragments @ .
d L 129 ok 1 id= 3 I + %
=]
= (¥ ou-panel ] - P - »
G 1

3. Addthe following class information class="oj-flex oracle-cx-fragmentsUI-cx-fragment-full-height" tO the
<oj-vb-fragment line before the > tag. Here's the resulting line:

<oj-vb-fragment bridge="[[vbBridge]]" name="oracle cx_ fragmentsUI:cx-panel"
class="oj-flex oracle-cx-fragmentsUI-cx-fragment-full-height">

4. Add the required resource parameter, which specifies the object you're displaying. Here are the values for
opportunities:

<oj-vb-fragment-param name='"resource"
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value='[[ {"name": "opportunities", "primaryKey": "OptyId", "puid": "OptyNumber", "endpoint":

"ex" } 11'>

</oj-vb-fragment-param>

Each object requires different values, which are listed in the topic Values to Use in Code for Standard
Components in Tables, Metric Cards, and List Views.

5. If you're displaying a list with opportunity revenue, you must insert this additional parameter because
opportunity revenue is a child object of opportunity:

<oj-vb-fragment-param name="child" value='[[ {"name": "ChildRevenue", "primaryKey": "RevnId"} ]]'></oj-
vb-fragment-param>

6. Add the required query parameter, which specifies the saved search that's the source of the data in your list:

<oj-vb-fragment-param name="query" value='[[ [{"type": "savedSearch", "params": [{"key": "queryUuid",
"value": "caf84b9d-b975-4b9d-b78e-41718b78£36e" }]},
$base.page.variables.dashboardFilters] ]]'></oj-vb-fragment-param>

In this example, the source is a saved search with the ID ca£84b9d-b975-4b9d-b78e-41718b78£36e. YOU Can obtain
the ID of saved searches by inspecting the code in the Chrome browser as described the topic How can I find
the UUIDs for a saved search and the IDs for its filters in Oracle Sales in the Redwood User Experience?.

7. Optionally, you can sort the list. For example, enter the following to sort the records in ascending order by the
last update.

<oj-vb-fragment-param name="sortCriteria" wvalue='[[ [{"attribute": "LastUpdateDate",b "direction":
"asc" }] 1]'></oj-vb-fragment-param>

8. Add the following style parameter. It applies the style for the dashboard layout. For details see the topic How
Information Displays in a Sales Dashboard Tab as You Add Sections

<oj-vb-fragment-param name="style" value="[[ 'dashboard' ]]"></oj-vb-fragment-param>

9. Addthe subviewLayoutld parameter to use the dashboardCardLayout. The dashboard card layout is where
you specify which fields you want to display in your list. Each object already includes the important fields.

<oj-vb-fragment-param name="panelCardLayoutId" value="[[ 'dashboardCardLayout' ]]"></oj-vb-fragment-
param>

10. Add the title parameter, to specify the title that displays on the list.

<oj-vb-fragment-param name="title" value="[['Hardware Opportunities]]"></oj-vb-fragment-param>

Sample Code for Displaying a List of Opportunities

<template id="hardwareOpportunityList">

<oj-vb-fragment bridge="[[vbBridge]]" name="oracle cx fragmentsUI:cx-panel'"class="oj-flex oracle-cx-
fragmentsUI-cx-fragment-full-height">

<oj-vb-fragment-param name="resource"

value='[[ {"name": "opportunities", "primaryKey": "OptyId", "puid": "OptyNumber", "endpoint": "cx" } 1]'>
</oj-vb-fragment-param>

<oj-vb-fragment-param name="query" value='[[ [{"type": "savedSearch", "params": [{"key": "queryUuid",
"value": "caf84b9d-b975-4b9d-b78e-41718b78£f36e" }1},

$base.page.variables.dashboardFilters] ]]'></oj-vb-fragment-param>

<oj-vb-fragment-param name="sortCriteria" value='[[ [{"attribute": "LastUpdateDate",6 '"direction":

"asc" }] ]1]'></oj-vb-fragment-param>

<oj-vb-fragment-param name="style" value="[[ 'dashboard' ]]"></oj-vb-fragment-param>
<oj-vb-fragment-param name="panelCardLayoutId" value="[[ 'dashboardCardLayout' ]]"></oj-vb-fragment-param>
<oj-vb-fragment-param name="title" value="[['Hardware Opportunities']]"></oj-vb-fragment-param>
</oj-vb-fragment>
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</template>

Sample Code for a List Of Opportunities with a Revenue Component

For an opportunity list with a revenue component, add the child parameter:

<oj-vb-fragment-param name="child" value='[[ {"name": "ChildRevenue", "primaryKey": "RevnId"} ]]'></oj-vb-
fragment-param>

Here's the sample code:

<template id="revenuelist">
<oj-vb-fragment name="oracle cx_fragmentsUI:cx-panel" class="oj-flex oracle-cx-fragmentsUI-cx-fragment-full-

height" bridge="[[ vbBridge ]]">

<oj-vb-fragment-param name="resource" value='[[ {"name": "opportunities", "primaryKey": "OptyId", "puid":
"OptyNumber", "endpoint": "cx" } ]]'></oj-vb-fragment-param>

<oj-vb-fragment-param name="child" value='[[ {"name": "ChildRevenue", "primaryKey": "RevnId"} ]]'></oj-vb-
fragment-param>

<oj-vb-fragment-param name="query" value='[[ [{"type": "savedSearch", "params": [{"key": "queryUuid",
"value": "73b21b33-db08-4327-b£30-88c3c9e0£70d" }]}] 1]'></oj-vb-fragment-param>

<oj-vb-fragment-param name="style" value="[[ 'dashboard' ]]"></oj-vb-fragment-param>
<oj-vb-fragment-param name="title" value="[['Revenue']]"></oj-vb-fragment-param>

<oj-vb-fragment-param name="panelCardLayoutId" value="[[ 'dashboardCardLayout' ]]"></oj-vb-fragment-param>
</oj-vb-fragment>
</template>

Add Code to Display My List

Here's how to add the code for the My List component to the Sales Dashboard. My List includes data from all objects.
For example, My List can include data from both opportunities and leads.

Here's the sample fragment code to add between the template tags.

<template id="myList">
<oj-vb-fragment name="oracle_ cx_ fragmentsUI:cx-heterogeneous-list"

class="oj-flex oracle-cx-fragmentsUI-cx-fragment-full-height" bridge="[[ vbBridge ]]">
<oj-vb-fragment-param name="query" value="[[ [{type: 'gbe', params: [{key: '_userRelevantItems',6 value:
true}l]}] ]1]"></oj-vb-fragment-param>

<oj-vb-fragment-param name="style" value="[[ 'dashboard' ]]"></oj-vb-fragment-param>
<oj-vb-fragment-param name="title" value="[['My List']]"></oj-vb-fragment-param>

<oj-vb-fragment-param name="entities" value="[[ ['accounts', 'contacts', 'leads', 'opportunities'] ]]"></oj-

vb-fragment-param>
</oj-vb-fragment>
</template>

In your fragment code, be sure to update the values in the "entities" and "title" parameters, as necessary.

Values to Use in Code for Standard Components in
Tables, Metric Cards, and List Views

Here's a list of resource parameters and values to use in your Sales Dashboard code for the different standard objects.
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Opportunities

Resource parameter: <oj-vb-fragment-param name="resource" value='[[ {"name": "opportunities", "primaryKey":

"OptyId", "puid": "OptyNumber", "endpoint": "cx" } ]]'></oj-vb-fragment-param>.

Name Primary Key Puid Endpoint Default List Template
ID
opportunities Optyld OptyNumber cX dashboardCardLayout

Leads

Name Primary Key Puid Endpoint Default List Template
ID
leads Leadld LeadNumber [ dashboardCardLayout

Value to use for <oj-vb-fragment-param name="resource" value=:

[[ {"name": "leads", "primaryKey": "LeadId", "puid": "LeadNumber", "endpoint": "cx" } 1]

Accounts
Name Primary Key Puid Endpoint Default List Template
ID
accounts Partyld PartyNumber X dashboardCardLayout
Value to use for <oj-vb-fragment-param name="resource" value=:
[[ {"name": "accounts", "primaryKey": "PartyId", "puid": "PartyNumber", "endpoint": "ecx" } ]]
Contacts
Name Primary Key Puid Endpoint Default List Template
ID
contacts Partyld PartyNumber X dashboardCardLayout
Value to use for <oj-vb-fragment-param name="resource" value=.
[[ {"name": "contacts", "primaryKey": "PartyId", "puid": "PartyNumber", "endpoint": "cx" } 1]

ORACLE

Default Table
Template ID

dashboardLayout

Default Table
Template ID

dashboardLayout

Default Table
Template ID

dashboardLayout

Default Table
Template ID

dashboardLayout
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Tasks

Name Primary Key Puid Endpoint Default List Template Default Table
ID Template ID
activities Activityld ActivityNumber X taskDashboardCardLay taskDashboardLayout

Value to use for <oj-vb-fragment-param name="resource" value=.

[[ {"name": "activities", "primaryKey": "ActivityId", "puid": "ActivityNumber", "endpoint": "cx" } 1]
Appointments
Name Primary Key Puid Endpoint Default List Template Default Table
ID Template ID
activities Activityld ActivityNumber [ appointmentDashboarc appointmentDashboardLayout

Value to use for <oj-vb-fragment-param name="resource" value=.

[[ {"name": "activities", "primaryKey": "ActivityId", "puid": "ActivityNumber", "endpoint": "cx" } 1]
Custom Objects

Name Primary Key Puid Endpoint
<object>_c Id Id cx-custom

Value to use for <oj-vb-fragment-param name="resource" value=:

[[ {"name": "<object> c", "primaryKey": "Id", "puid": "Id", "endpoint": "cx-custom" } ]]

Embed Content Created in Oracle Fusion Data
Intelligence

Here's how you can embed content created in Oracle Fusion Data Intelligence.

Here's an example of the type of content you can embed:
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For more information about the Oracle Fusion Data Intelligence embedding framework, see the Visualizing Data and

Building Reports in Oracle Analytics Cloud guide.

Prerequisites

- You must register your domain as a safe domain. See the topic: Typical Workflow to Use the JavaScript

Embedding Framework with Oracle Analytics Content
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- Before adding an Oracle Fusion Data Intelligence (OFDI) component to the Sales Dashboard, you must retrieve

the Object ID from your existing OFDI content:

a. Navigate to the OFDI host where the analytics workbook is saved.

b. Click the Actions > Inspect.

Shared Folders » Custom » HP Exploration

Today

g

HP Customer 360 (x50

I Llll
Iilii
SF Reponts [ - 2 by Tosibory P
Thits Yaar
T i

CN Sales Starter Repaats

Fourcaating Embed

My Folders  Shared Fobders

c. Next to the Object ID, click Copy.

E Revenue Trend copy

Wk ook
General
ame | Revenue Trend copy

Share Description

Access

plyush. ja jain@oracle.com
_reated By piyush ja jain@oracle.com Feb 14, 2023
ed By piyushjajain@oraclecom Feb 14, 2023

ct D j@ Cc:?j

(Shared Folders/Custom

/HP Explaration

Close

d. Paste the Object ID, along with the Fusion Data Intelligence host URL, into a separate file for later use. For

example:
i. Oracle Analytics Host:

https://0ac01-gse00010001-px.analytics.ocp.oraclecloud.com/
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ii. Object ID:

/@QCatalog/shared/Custom/HP Exploration/Revenue Trend copy

Add an Oracle Fusion Data Intelligence component to the Sales Dashboard

1. Display the Sales Dashboard and open the Oracle Visual Builder Studio.
2. Inthe Properties pane Components tab, search for and click Contents Container.
3. On the Contents Container Properties pane, click the + Section button.

¢ Contents Container | Sales Fragments

sapsadouy

General  Sections |14

‘F Contents Container

Section Rules Editor
& Ruh;s . & Rules
Al Sections 4+ Section
Dieals At Risk Saved Search Table ¥
Lead Amounts By Team Member Chart bl
My Appointments Saved Seanch List ¥

My Favorite Opportunities Saved Search List 3

4. Select + New Section at the top of the list.
5. Inthe Properties New Section pane, Title field, enter a title for the visualization component.

Note: The title is the name of the component and doesn't appear on the dashboard at runtime. The runtime
title comes from the dashboardritie parameter that you add to the visualization code.

6. Click the Go to Designer link.
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7. Click the Code button.

Live Design Code

Your new Revenue Trend section displays with empty placeholder template tags.

< Return to page

21  <template id="revenueTrend'>
22 </template>
23

8. Insert the following code between the template tags:

<oj-oa-project host="https://oaxprodmgmtfawdev4-idbelglbntjz-ia.analytics.ocp.oraclecloud.com"
project-path="/QCatalog/shared/Custom/HP Exploration/Revenue Table" b-show-filter-bar="false"
class="oj-flex oracle-cx-fragmentsUI-cx-fragment-full-height" compatibility-mode="yes" active-
page="insight">
</oj-oa-project>

You will need to replace the following values (You can do this in the next step):
o The host name

o The project path. This is the link to the report you want to include.
The b-show-£filter-bar Option is set to false. No filter bar will be shown in the report.
The active-page is set to "insight". If the workbook includes multiple pages, the first page will be displayed.

The compatibility-mode Is set "yes". This legacy setting allows compatibility with older report versions.

9. On the Properties pane, in the Host field, enter the host URL that you saved, such as https://0ac01-
gse00010001-px.analytics.ocp.oraclecloud.com/.
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10. In the Project Path field, enter the repository path of the project to render, such as /ecatalog/shared/custom/np

Exploration/Revenue Trend copy.

| Note: This is the Object ID of the Oracle Analytics Cloud workbook that you saved.

{ oj-oa-project

General Events Al

I Q1 Filter l

B Show Filter Bar

false |

Compatibility Mode

ves |

Content Editable

falee l

Direction

Left To Right | = |

Draggable

Hidden

falze - |

Host

https: ffoaxprodmgmtfawdevd-idbel glbntjz-
ia.anahytics. ocporaclecloud.com

Language

Project Path

J/@Catalog/shared /Custom/HP Exploration/Revenue Table ‘

11. Now that you've created the dashboard panel component, add it to the appropriate sales dashboard.
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Add the Sections to the Tab's Contents Container

You can add up to 5 sections in a tab. Each section can display a table, a list, a visualization, or embedded Oracle Fusion
Intelligence content. You can add sections you created, and sections provided by Oracle.

Tip: Before you start, read the topic How Information Displays in a Sales Dashboard Tab as You Add Sections to
familiarize yourself with the content styles that determine how tabs are laid out as you add sections. If you add just
one section, for example, that section always takes up the whole tab. As you add more sections using the default
layout style, the first panel always remains bigger that the rest, but shrinks to make room for the others.

1. After you've created the sections and added the appropriate code, click Return to Page.
2. Inthe sales-dashboard Properties section, Components tab, search for Contents Container.
3. Click the Contents Container link

DashboardLayout [\'..!:I sabes-dashboard =

Design | Code |  sales-dashboard | CX Sales 3
- %
g
w
Components (4] Constants (7
O Fe

= ﬁ Dashboard Fragrment
™ cx-search:bar

E! Metrics Container

ID Contents Contalner I
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4. C(lick the Rules button.

{ Contents Container Sales Fragments

san) sadoag

General  Sections (14)

¥ Contents Container

Section Rules Editor

Controd rules that make it possible 10 deplay different
arrangements sccording to conditions.

4 Rules & Rules

All Sections =+ Section
Deals At Risk Saved Search Table »
Lead Amounts By Team Member Chart »
My Appointmients Saved Search List >

My Favorite Opportunities Saved Search List >

My List »

5. Under the Extension Rules heading, select the appropriate rule (the copy of the contents container you made).
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6. Under the Available Sections heading in the right-hand pane, click the Add Section (the plus sign) button to

add a section.

Page Designer Acthom Chains Ewent Listenars Evenis Types Wariables (11 JareaSoripd 30N Settings
Contents Container Rules e X
O Fiter + pue  Copy of Sales Representative - Pipeline Content o @
Extension Rules
1 Conditions Edit
Copy of Sales Representative - Pipeline Conte
W $baie.varisbles . selectedipiTob == sectiond
Copy Sales Manager - Pipeline Content
Sections Included in Rule
Built-in Rules
My Open Opportunities Seved Search Table E’
Sales Manager - My TaDo's Content
My Favorite Opportunities Saved Search List &
Sales Manager - Pipeline Conbent
hiy Open Leads Saved Search List B
Sales Representative - My ToDo's Content
My List Of Oppartunities &
Sales Representative - Pipeline Content
Available Sections
Daals At Risk Saved Ssarch Table e +
Lead Amcunts By Team Membsr Chart -
My Appoinimenis Saved Search List +

I Note: The contents container can include no more than 5 sections.

The section is added as the last section under the Sections Included in Rule heading.

7. You drag the section to a different position.

8. You're now ready to preview the new tab. See the topic Preview Your Changes and Save Them to the Git

Repository.

Predefined Content That You Can Add to Your Dashboard Tabs

Oracle provides you with several predefined tables, lists, and visualizations that you can add to your Sales Dashboard

tabs.

You can add these components to any custom Contents Container

Lists
- My Appointments saved search list
- My Favorite Opportunities saved search list
« My List
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My Open Leads saved search list

My Open Opportunities saved search list

My Open Tasks saved search list

My Overdue Tasks saved search list

My Team's Open Leads saved search list

My Team's Open Tasks saved search list

My Team's Overdue Tasks saved search list
Tables

Deals At Risk saved search table

My Open Opportunities saved search table

My Team's Opportunities saved search table

- Tasks Due in the Next 30 Days saved search table

Charts

Lead Amounts by Team Member chart

My Team's Performance chart

Preview Your Changes and Save Them to the Git
Repository

As you configure your sales dashboard, you can preview your changes and then save them to the Git repository.

1. Test your sales dashboard edits, by previewing your application extension:

a. Click the Preview button to see your changes in your runtime test environment.

P ©® Q ‘ Publish | =

b. The resulting preview link will be:

https://<servername>/fscmUI/redwood/cx-sales/dashboards/sales-dashboard
c. Change the preview link as follows:

https://<servername>/fscmUI/redwood/cx-sales/application/container/dashboards/sales-dashboard

2. If you've
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3. Save your work by using the Push Git command.

Navigate to the Git tab, review your changes, and do a Git push (which does both a commit and a push to the
Git repository).

< Workspace2 > extend-next-gen-sales.git/20220830 ;
ol Git @ D detail
A Q Filter Switch Branch
&= » Changed (1) Commit. Commit
= Pull
.
® Merge
& Reset to HEAD
(%) Q

How Information Displays in a Sales Dashboard Tab as
You Add Sections

A sales dashboard can include anywhere from 1to 5 sections in each of the tab pages you create. As you add sections,
the display adjusts according to an underlying content style.

You can choose between 2 content styles:

- The default above-fold content style minimizes vertical scrolling by adjusting the size of the first section as
you add more.

- The alternate hero-plus content style always displays the first section to the full width and height. All other
sections appear underneath.

The Default Above-Fold Content Style

In the above-fold style, the first panel is the biggest section, but the panel shrinks horizontally and vertically as you add
sections. Salespeople don't have to scroll if they have a standard-sized monitor.
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Here's how the above fold layout changes depending on the number of sections you specify in the container.

. 1section

The section takes up the full width and height of the content region of the tab.

. 2sections

The first section takes up two-thirds of the width at full height and the second section takes up the rest.

. 3sections

The first section takes up two-thirds of the width at full height and the second and third sections split up the
remaining third horizontally.
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. 4 sections

The first section takes up the full width of the dashboard but only half of the height. The three other sections
split the remaining space below the first section.

- 5sections

The first section takes up two-thirds of the width at half the height, The second section follows with one third of
the width and at half the height. The three remaining sections split the remaining space below the first section.

The Alternate Hero-plus Layout

The hero-plus layout displays the first section, the most important information, over the full width and height of the
available space. As you add sections, they appear below. Salespeople may have to scroll down to see them.

- 1section

The first section takes up the full width and height of the space available.
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. 2 sections

The first section takes up the width at full height. The second section displays below.

. 3sections

The first section takes up the width at full height. The remaining 2 sections display below next to each other,
each at half of the width.
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. 4 sections

The first section takes up the width at full height. The next 2 sections display below, each at half of the width.
The fourth section appears at full width below.

. 5sections

The first section takes up the full width and height of the dashboard. The rest of the sections appear
underneath at half the width.
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Switch Between the Two Sales Dashboard Content Styles

Here's how to switch to the alternate hero-plus style or back to the default. The hero-plus style gives priority to the first
section in the contents container and displays it over the full width and height of the available space.

1. Edit the Sales Dashboard page in Oracle Visual Builder Studio.

[ — PA—— \ poiieatemtaleg P [ — L [ Y [N ——
g Degen Lo Lo asa Lee b patiorgt PR
i b H | P = | e [E L ﬂ:.-.p [ naben- kel | {30
b
; = Splassifensn . A
et
=g B
B Sales Dashboard
§ G Lot D -
- o iy T B w R . - F
K Drwiait P 1 BRI B0 ndl
-
g
Cpopuce naiadrbais, st Bk
e - e
] N A et g - Anzered 2 D atinrn
Farlars Hinylrg - * a8 &
r B 1 B4
.. weitas H . b - * [T PR
- [ e
i
- -
- L ] bly Braas (pren Lk
= Weus're all caught up for now Tou're all caught up Sor pow

2. In the Properties pane on the right, click Constants (the tab highlighted by callout 1in the following
screenshot).

sales-dashboard | O Sales

Companenty (4 f.ﬁ-lﬂ.'.&u'l'!u :o

L1 Filke
L e

A :wunﬁcﬂte »

A defauliMetricCard »

Default metric card

LETTER LI

B2 dynamicDashboard >

3. Click Content Style (callout 2).

79
ORACLE



Oracle Fusion Cloud Sales Automation Chapter 5
How do | configure the Sales Dashboard in the Redwood Configure the Dashboard

User Experience?
4. Switch content styles by entering either hero-plus or above-fold in the ContentStyle field.

£ A contentStyle | O Sales

EETITES LT

Deefined by
[ sales-dashboard | O Saled

B contentStyle

B bsgrre-told

Usapes

Layouts That Specify What Fields Display in Tables and
Lists and How

The contents container specifies the source of information for a table and a list. You use a layout to specify which fields
display as columns in the table or a list. The layouts determine which fields display, their order, and their relative widths

to other fields.

Note: If you created your table as a visualization, this topic doesn't apply to you. That's because you specify the
columns you want to display in the tabular chart visualization itself.

There are separate layouts for different sales objects. For opportunities, the 2 relevant sales dashboard layouts are listed
under the Dynamic Table heading:

Dashboard Layout, which specifies the columns in tables.
List Layout, which defines the fields in lists.

] Layouts - Getting Started :El sales-dashbaard -'% Opportunities =
A wd,  Filter Rube Sets 18] Frelds Business Rules Walidaticns Templates (13

P& MdiClaims

v dr MdiRequests QL Fike
s w % Dipportunities

*  Dynamic Form
v 4 ChildRevenue
= & Interviews ~ Dynamic Table
@ 4 Hote Dashboard Layout | cxsales | @
n 4 OpportunityCas Table displaying opporiuntiies in dashbosrd
4 OpportunityCes List Layout | € Sales

'% Define the display column fields for list

4r OpportunityCor

You can create different layouts for different containers.

To understand how to specify the fields in layouts, see the example provided in Specify the Columns in a Sales
Dashboard Table and Their Widths. You can edit list layouts in the same way.
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Specify the Columns in a Sales Dashboard Table and Their Widths

To specify which columns appear in your sales dashboard table and control their width, you copy and configure the
dynamic table Dashboard Layout.

In Oracle Visual Builder Studio, click the Layout tab and open the CX Sales node.

Scroll down or search for Opportunities.

Click Opportunities to display the opportunity layouts.

In the Dynamic Table section, click Dashboard Layout.

Duplicate the isDefaultDashboardLayout.

Open the copy.

Select and drag the fields you want to display from the left pane to the Select fields to display pane.

You can reorder the columns in your table by using the handles in front of each field.

You can adjust the width of each field by clicking on the field. The width controls display as percent of the table
length.

VI AWNA

For example, the opportunity Name width is set to 19% by default, so the name column will always display at
19% of the total width of the table at the default window size.

If the user views the dashboard in a smaller window, then any field without a width value automatically adjusts,
but the name column will stay the same width.
o Clearing all of the widths for all the columns causes the table to adjust all of the columns.

o If you add more columns that the width of the table supports or the percent entries add up to more than
100%, then the table displays a scroll-bar.

Note: Although the Minimum Width and Maximum Width fields display 33% by default, these aren't actual
values. The percentage value is merely a placeholder.

How to Find the UUIDs for Saved Searches and IDs for Its
Filters

Here's how to find the Universally Unique Identifier (UUID) for a saved search and the various IDs of its query
parameters in Oracle Sales in the Redwood User Experience. The IDs are required to reference the saved search and
filter parameters in Sales Dashboard layouts, including metric cards and tabular and list views. The IDs are also used in
Oracle Transactional Business Intelligence analyses. You'll need an ID to filter by opportunity sales method and sales
stage, for example. A UUID is a is a 36-character alphanumeric string that can be used to identify information, such as
rows of data within a database table.

Here's how to find the UUID for a saved search:

1. Open the list page of the object in the Chrome browser. For example, if you need the UUID for accounts, for
example, click Accounts on the home page.

2. (lick in the action bar (callout 1in the following screenshot) and select any saved search other that the one
you're looking for.

3. Right-click the page and select Inspect from the Chrome browser menu.

4. Click the Network tab (callout 2).
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5.
6.

~

0 0

Reload the browser page.
In the action bar, switch to the saved search you want.
Click the Network tab again.
Enter que in the filter field to filter out the queries (callout 3).
Select the last queries entry in the list (callout 4).
My List for Accounts
(=] Show Smart Lt True X 'of'ﬂ‘ ng by keywaord o
|
x m Elements Consale Recorder J& Sounes Metwork
@ @ v O [ Presens bag [ Dasable cache Mo theaithng 7
[{]uf- e ﬂ] O brwert O Hide data URLs [ Hide eated
| 10000 e 000 =8 0000 0000 1 50000 4
Hame
Ui} deseribespenspiimetsd stabMode s minmalirescurces = ré..roes a2 CralesForss
{F quanss aocads sutarlidrindispalic st ond =481 6579791 - 1 Sedd icboad Biant
{1} queres
U} quenes
Hik queries o

10. With the last queries item selected (callout 1in the following screenshot), click the Payload tab (callout 2).

1n

The UUID is the string of characters following queries/ in the copiedFrom: line. For example:
934fb7ec-658£-4718-b38c-95£8£5e6c431 (highlighted by callout 3).

Recorder Sowces  Metwork  Performance imsghts A Performance  Memory  Applicaton  Secusity Lightheouse  Oiracle Accessibslity
® & T 4 Preserce log [ Duskdecache Mothoiting + T L &
1 SR04 e 50000 ma EER000 rp SR RA0N0 H0000 rp FRAR0C = SO0 4 A50000 SAHE0CH =y SELE00 wa BRG0G0
e
Namg X Headers FPaposd  Prevew  Reiponte  Ietatar  Timing Cooloss
) deseribe openapiTmetadatahd v Request Payload i SoUTOE

LF Gu :f R ; § 5 " " S i pnE — - P
U quenesisoteni=usaradmints v {apfregationResulte: Falie, spplicaticad: [“ORALLE-IS5-APP=], onlyDeta: true, eatity: “Oopartuniny™,-}
(% quenesacorsszussrAdminda. aggregationResults: False

4% quenes * soplicetions:

DRACLE-155-2897]
i} queries o copledFrom: =g 43fedd 33 3n22- 4610 aFSe - cOeBAB15a328"
entity: “Opo ity

¥ Flgldg: [“OatyIa®, “PrisssyRpcinol WisPron®, "MNase®, “LustoBsrdccount™, *Prisaryecthct. Rivalsount™, )
keywords :
language: “en”
limit: 15
offset: B
onlyData:r tries
1 "$and™;, criteria: [f{op: "§in™, sttribute: =StatusCode™; walues: ["OFEN"]}.=]1}
is: [{op: ¢ 8ttribute: “Statuslose™, values: [“OPEN"]1},-]
: {ep: "$a%, sttribute: “Statuslode®, velues: [SOPEN]}
: {op: "Seq™, attribute: “"RecordSet™, value: “ORA_MYSUBORDSSALESTEAMDRTIES™)
® 21 {op: "§in=, attribute: "SalesMethodId™, values: [~I000090444TETE57]) e
® 5; {op: ~“$in=, attribute: “SalesStage”, wvalues: [~I0000084dTETH1" ]}
opr "Sand™

skipInvialfoFfelas: trve

sorti

12. To view the IDs of the query parameters, open the q: list (callout 4). For example, here's a sample sales method

|DZ{op: "$in", attribute: "SalesMethodId", wvalues: ["300000044476789"]}
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Specify which Dashboard Tab Displays by Default

You can specify which sales dashboard tab is selected and displays when a user opens the Sales Dashboard by setting
the constant defaultMetricCard in Oracle Visual Builder Studio.

1. Open the Sales Dashboard in VB Studio.

2. Obtain the ID of the metric card:
a. On the sales-dashboard tab, click the Page Designer subtab.

In the Design mode, click the Metrics Container section.

c. Click the Sections tab.

b.

d.

L [+ | FittoCanvas = it

Live | Design Code

Sales Dashboard

= Try searching by keyword

auto

100% -

My TD-Dro Pipeline
2 S 1M
Tasks Due in the Next 30 Days
Ty Subjec = Acco S Qwirn
Mo data to display.
copy the ID.
O [+ FittoCanvas * || auto | ¥ | aulo

Live Design Code ]

100% -

{ Metrics Container | Sales Fragmanis

Sﬂﬁunsme

by Oppeoetunity List

General

My TaD rics | Sales

Sales Manager Hardware Pipeling

Sales Manaper Pipeling Metrics | Salss

Cales Representative Pipeline Metrics

Section

1¢]
hardwarePipeling

Title
Description

Label Hint

Hardware Pipeline

Saley

=+ Section

Access for Application Extensions
[ Disabled | Enabled

3. Onthe sales-dashboard tab, click the Variables subtab.
4. C(lick the defaultMetricCard constant.
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5. Inthe Default Value field, enter the ID of the metric card for the tab you want to show as the default.

unities-detail o [y sales-dashboard x B opportunities O ag ~chetail 4 Accounts O ~

Page Designer Action Chains ~ Event Listeners  Events Types WVarlables (10y  JavaScript JS0N Settings

I | ] Constant
[Q Fiter [V * | 4 Constant 4+ Variable
D
~ Constants Extension Read,/Override A, defaultMetricCard | Sales
Description
E= dllowPersonalization  Sales @
Default metric card
A, contentStyle | Sses Default Value

A defaultMetricCard | Sales -e e salesManagerPipelineMetrics o

B2 dynamicDashboard | Sales  ® Usages

* [ enableFilters | Sales  ® Mo usages found in this extension

EZ enableSearch | Sabes
AL pageSubtitle | Sales

£ pageTitle | Sales

~ Variables Extension Read  Extension Write

{ } dashboardFilters | Sabes
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6 Enable Global Search and Filtering

The Dual Functionality of the Sales Dashboard Ask
Oracle Bar

The Sales Dashboard Ask Oracle bar serves two different and unrelated functions: keyword searches and the filtering of
the reports in the sales dashboard itself.

Salespeople use the Ask Oracle bar to:

- Search by keyword through all the sales information they can access, including activities, emails, leads,
opportunities, accounts, and other business objects.

Filter the information in the active tab of the sales dashboard. For example, they can display data for a narrower
time period or compare the performance of one manager to another.

Search Through All Sales Information by Keyword
Here's how to search by keyword:

1. Enter the keyword in the Ask Oracle bar.
2. If you don't see the item you're looking for in the list, click Search to view all the results, filter them, and take

actions.
Keyword Search
Callout Description
1 Enter keyword.
2 View list of most often-accessed items matching the keyword. You can open individual items by

clicking on links.
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Callout

D

L,
11

Q

Description

Click Search to view all results and take actions on them.

Sales Dashboard

o pinnacle o

Pinnacle Technologies
3903 Ambassador Caffery Plkwy LAFAYETTE, LA 70503
Joshua Baker

Send Introduction Email
E - mauil

Send Introduction Email
E-maail

Followup Call

Call
10/T9/24 11:00 PM

14.7kWm Diesel Variable Speed Engine
Pirnacle Technologies
M e

Search pinnacle e

Accoint

Task

Task

Appointment

Assat

3. Inthe Search results page, you can add different search terms and filter by object.

Key Features of the Search Results Page

Callout

Description

You can update the initial keyword.

Each search results indicates the object.
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Callout

Description

You can filter results by object

Search Results

pinnacle 3

o

Pinnacle Tech...

3903

Ambassador
E] Caffery

Phowy LAFAYETT

E. LA 70503

High Techroiomy

Send Introduc...
Z= E-mail

Marta Studinger

Send Introduc...

£=  E-mail

Sara Sales Rep

Followup Call

Call
Fusion Admin

Try Searc h:nﬁ by keyword or acdd a filter

Joshua Baker

2625

418724

10/29/24 11:00
PM
11 /8,24 12:00 AM

hittpe f fwrener Pi... o

Account

Hot started
Task

Hot started
Task
Appointment

Filter by Object
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4. You can take actions directly on the search results by clicking the three dots Actions icon highlighted in the

screenshot.

Chapter 6

Enable Global Search and Filtering

For example, you can edit an account record, and create contacts, opportunities, notes, tasks, appointment for

the account. And you can and you can send an email.

Search Results

Pinnacle Technologies
3903 Ambassador Catfery Plwy LAFAYETTE, LA
T050

) Techy

Send Introduction Email
o= E-mal

Marta Studinger

Send Introduction Email

= E-rmal
e

Sara Sales Rep

Followup Call

]% Call

Fusion Admin

[=] pinnacke X Try searching by keyword or add a filter

Joshua Baker

2/6/25

4/18/24

10729724 11:00 PM

117624 12:00 AM

Filter by Object

L ARt L T B T T B —

AcCount E

Edit

Create Contact
Create Opportunity
Create Note

Create Task

Create Appointment

Send Email

Filter the Sales Dashboard Content

Salespeople can filter the contents of the dashboard to focus on a subset of the information.

Four filters are available: Time Period, Team, Territory, and Product Groups. The filters display as buttons and are also

available for selection in the search box itself.

Sales Dashboard

©  Trysearching by keyword

Tirmse: Pesricd

Team

Territony

Produsct Groups

For example, you can filter the information in the KPI and in a visualization in the tab by clicking the Team filter button

and selecting team members.
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Sales Dashboard
o | Team ()] X Trysearching by keyword
" Selected b
&1 [ ierarchy
QU sl Raeaed o] = & Coror Baery
¥ (3 Samuel Raraed
My Te Jaenrs Sirdn =
¥ IEI_'I_I:W,-_, Srrith
Pig
25 B E Sarah Williams

Both the metric and the visualization now display data for the selected team members.

Note: If you're creating visualizations from OTBI analyses, you must make sure that those analyses include prompted
criteria for the filters you enable.

Enable Custom Object Search in the Sales Dashboard

Perform the following setup to enable search of custom objects using the search bar in the Sales Dashboard. The search
bar in Sales Dashboard provides the same function as the Global Search box in the Classic UL.

Note: This setup isn't required for standard sales objects, but you change which fields you want to display in the
search results for each object, by copying its search card layout and editing the copy. For details, see How can | change
which fields display in Sales Dashboard search results for standard objects?

Prerequisites
1. Create the custom object and fields in a sandbox using Application Composer.

Note the following when creating fields:
Make sure the Include in Service Payload option is selected. This option enables the field for the REST

API.
o The Searchable option applies only to Classic Sales Ul with CRM Search.

o A checkbox field appears as a switch in the Redwood Ul with a value of either on or off.
2. Publish the sandbox.
3. Inthe Setup and Maintenance work area, open the Configure Adaptive Search task:
o Offering: Sales
o Functional Area: Foundation
o Task: Configure Adaptive Search
4. On the Configure Adaptive Search Setup > Quick tab, select the custom object to enable for search.
5. Click the Setup > Advanced tab.

o
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6.
7.
8.

10.
1n
12.
13.
14.

15.
16.

17.

Click the custom object in the left pane.
Select Enable for all of the fields you want to expose in the Redwood UI.
Select Include in Keyword Search option for fields you want to enable for search.

Note: Only fields that display as text are searchable. For example, you can't search on date fields or check
boxes.

v Atvwecsd

Brancy -
,_:D o tipmidn | sl b Bdogiias Same b x Ailiana * LT Maaa gied Do
" sl

T— Cionid H L] Crartification

-1
Corligas Ul ngure | o
= A
B Corllpurs Dol iy Pl Finlile
) Asalyrod chad in dbads in
o - Fasia Display Mawe & Type Erabke L] Edymors Ol
[ o) L] Aoipreie
B W Dl e Cgargatge_id_hogas - Aprousd Cyrllbgus Crnpce Lad (Dyman
L LRr
Parrefuma mridemd o Hama Tout o o !
.
@lor
[ - 1 " "

From the Actions menu, select Partial Publish.

Select the custom object and click Proceed with Partial publish.

You can monitor the progress of the publish process on the Monitor tab.

After the process completes, create a sandbox with Application Composer and enter the sandbox.

In Application Composer, click CX Extension Generator.

Create the Ul and smart actions for the object as described in the topic Create a New Application Using the CX
Extension Generator. The CX Extension Generator automatically creates the search layout template for your
search setup.

Note: Unless this is your first time using the CX Extension Generator in this environment, you must import
your configurations from Oracle Visual Builder Studio. Creating a new extension, can delete your previous
work.

Export your changes from CX Extension Generator and import them into VB Studio.

Make sure that the user testing the global search has access to the Sales Dashboard. By default, the application
includes sales dashboards for sales manager and sales representative job roles. The user must have one of
those job roles to test the search.

Create some records that you can test the search with.

Set Up Global Search

1.

2.

Open the Configure Adaptive Search task in the Setup and Maintenance work area:
o Offering: Sales

o Functional Area: Sales Foundation
o Task: Configure Adaptive Search
Click the Configure Global Search tab.
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3. Click the custom object name.
4. Select the Display in Ul option.
5. Inthe Configure Search Results section, click Edit for the Title field and select the object name.

Note: The entries in the Configure Search Results section specify which fields display in Global Search for the
Classic Ul. They don't apply to the Redwood Ul. However, entering a title is required.

6. Click Save and Close.

Configure Adaptive Search @

Monitor Configure Global Search

Satup Save  Save and Close = Cancel
il Parameters objacte Q Configure Global Search : Payment e

Configure Ul * Ascount /| Display in Ul

* Activity
8, Configure Glob o Configure Search Results
* Asset

Specify fields to be displayed in the different sections of each search result.

Campalgn
* Title Paymant Name y.
Contact

i -
+ Deal Registration L ? y
+ Lead .

Line -

2 4
* Opportunity
“«

* Partner
* Partrier Conta-t

Payment e

7. Open the Sales Dashboard in the Sales application.

Open Oracle Visual Builder Studio (Your initials > Settings and Actions > Edit Page in Visual Builder Studio).
9. In VB Studio, click the Layouts tab.

10. In the right pane Rule Sets subtab, click the Search Card Layout entry.

o

Ll Layouts + Getting Started [ accounts-detail B payment_e [ sccounts-Nst 4 Payment. e x

RuleSets 10y Conmtext Fields. (2 Busiress Rules Templates Action Chains (11 Event Listeners (11 Events Types Varial

_:}_

o]

& MNote
~ Dynamic Form
= Customer Experience (CX) .
Edit Layout ¢
b Sales Page region where users can edit an Payment_c

Header Layout

¢ 0D & 0 b

» Other Page region that displays a concise Payment_c summary on the header region of the details page.
Panel Card Layout
Page region where users can view Payment_g details in panel
Search Card Layout #
Page region dsplaying Payment_c in global search results.
single Field Update Layout

Layout used for Singhe Field Updates,
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11. In the default Search Card Layout, click Edit.

sl B pay=esn Lo FTE Y & Leads A PRaiter dp bt el A Py eraL el aliedtioe ¢ ﬁ,{-.-'l-n:w-_-. W Rl
Bkt Sty 30 Contiedl  Fieklail Dusleess Mok Beenplaben (7 AcHos Ohaies 30 Dweeilistenen 10 Beerds  Typen  Vorebles (3 Jewfospt  FON lesap
FueSeme ¥ Sewerh Cord Loyons =

i_ L ritar EEE)  visplay Logic®
B ot o =

sewehiard-rde JF BE® - -~ @

.. B ek ns ndd sandimen

|....Em.. [
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12. Inthe Search Card Layout, move the fields you want to display in the search results from the list to the right-
hand pane.

Note: To allow users to drill down from search results into individual records, be sure to add the
RecordName_hyperlink field instead of RecordName.

Rl St 1200 Conben Febeti i Briirieria Rulei Femiplated Action Chalf (11 Evirat Linteners (11 Ewviriti Typei Wier| e |2 St JE0H
Rule Sets Seawch Cand Layout Layout dedasdr
% 1 - Set arache_ox_Pragimentallox-search-card parameters
[y A
Suppessed Faeldy

H A Cortsficationhiotes ¢

B o conied .
& Meml

B A DatsCertified c
O A owaZexiwner s { } RecordHame_hyperlink
D T OraZoalwner_kd_c £ Hemz
Al Figkdi
B Corafeid ¢
|:| B Actioralen

v 1} amschment et
B A Combemenbion ¢ £ Deweleriled c
H B Gt
O # coniicns ot
D.ﬁ.tmu:u-nmfud! B Cortfatontioie ¢
[ A cressecisy
A FHemS
O A cremiontiss
[ A CureyCommme T
O A cureneyCode Ay —
B A Dastertified c
B#uw
[ A LesUpdaseDate & memT

O A Lensuspdanediny
O A LestupasncLogin
] I:H 1 Mo

I Note: Don't move fields into the Icon field. You can't add icons on this page.

In the runtime application, the search results are divided into 3 columns. The fields in Item 1to Item 3 in the
layout display in the first column, Iltem 4 and Item 5 in the second, and Item 6 and Item 7 in the third.

Each row of search results also includes the object name and a list of actions (not part of the Search Card
Layout).
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emall M Try searching by keyword or add a filter

Search Results
o

Followup demo
Demo

Gupta Atanu

Send Followup Email
£= | E-mail

Gupta Atanu

Send Intro Email
£=| E-mal

Gupta Atanu

Send an Intro Email
£=| E-mail

Gupta Atanu

11720,24 6:00 P

11/20/24 700 PM

11727724

12713724

12714724

Nat started

Complate

Complete

Filter by Object

Appointment

Task

Task

Task

13. Click the Sources tab.
14. Find and click catalog.json.
15. Click the JSON tab in the right-hand pane.

q.iﬂme

artification_c
i —

By dashboards

[} sales-dashboard

L Filter :
“, l 2
3

5 - B eensionl 4
5

e = By sources ;
v O] dynamicLayouts 7

G 8
* B services g

L] - self 18
EL 11

B o v [ callSpectraPraxy 12
13

& 1 & catalogjson e i
] uu 15

16

{ } vb-extension json 17

D Jgitignone 18

19

B Gruntfile.js 28

{

"backends™: {},
"services™: {
“cx-custom™:

“openapi®: “3.0.0%,

“info": {
“"m-wb®:

“serviceType™: “adf-rest”,

"publichccess": |

“oracle_cx_salesUI™

]
}
b

“servers™: |

i
L3

"wrl™: “vb-catalog://backends/base
“wariables": {

“"REST-Framework-Version™: {

“default™:

}

-g=

16. Add the following code after "serviceType": "adf-rest":

’

"publicAccess": [
"oracle cx_ salesUI"
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1

The resulting code looks like this:

"backends": {},
"services": {
"cx-custom": {
"openapi": "3.0.0",
"info": {

"x-vb": {

"serviceType": "adf-rest",
"publicAccess": [

"oracle cx_salesUI"

]

}

}l

17. Click Layouts > <your custom object> > JSON.

18.
19.

20.

21.

In the JSON subtab, find SearchCardLaout.
Under displayProperties, following the "Id" entry, add the following:

’

"RecordName hyperlink"

The resulting code looks like this:
"layout": {
"displayProperties": [

" Idll ,
"RecordName hyperlink"

] r

In the "RecordName_hyperlink" row add :"hyperlinkTemplate".

The row should look like this:

"fieldTemplateMap": {
"RecordName hyperlink":"hyperlinkTemplate"
}

Click Preview and test the search.

ORACLE

q Layouts -+ ﬁ: Cereilic ation ¢ = % dashbaards 3 el -dlashboand
i o Fioes Rule Sefs it Comtext  Fields 2 Business Rules  Templades
®
11 “layouts™:
& - -l,‘& rification ¢ e 98 “SearchCardlayout™s
a7 “layouts™: |
o 4 Note l ]
] “default™:
o b4 Payenent g ] “layoutType™: “fora™,
18 - wt= o
11 “displayPFroperties”;: |
¥ Customer E e (X
e ] 12 “1d=,
313 |Ercoratiane_hypertink-
8 14 ],
“templateld™: “SearchCardTesplate®,
R “readonly”: “true”,
"labelEdge™: "none
“upedIn™: |
F "searchlard-rule”
1
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How can | change which fields display in Sales
Dashboard search results for standard objects?

You can change the fields that display in Sales Dashboard search results for any of the standard objects by duplicating
its predefined Search Card layout and updating the list of fields in the duplicate. Here's how.

Make sure that the fields you want to add to search are enabled for Adaptive Search and for keyword search.
Open the Sales Dashboard in the Sales application.

Open Oracle Visual Builder Studio (Your initials > Settings and Actions > Edit Page in Visual Builder Studio).
In VB Studio, click the Layouts tab.

Click the name of the object.

In the right pane Rule Sets subtab, click the Search Card Layout entry.

Duplicate the Search Card Layout and edit the copy.

NoUhAUWUNRA
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8. In the Search Card Layout copy, delete any fields you want to remove and move the fields you want to display
from the list to the right-hand pane.

B St 1200 Contea Pl i Brribrigria Pulei Frmplatei Action Chali (11 vt Libenedi (22 Eviiti Typei Wil e |2 SreaSsria 1500
—_—
Fube SE0S Sewch Card Layout Layoit detalt
§ O Filter St oracle_ox_fragmentsUlcx-search-card parameters
A boon
Suppesied Fieldy

H A, Cortficationbioies ¢

B © corned c -
Hem

- A, DateCerulied ¢

[ A ovaZextene < { } RecordHame_hyperlink

D T OvaZoaOwner_ld ¢

A, Memz
s B Corehed ¢
O A actiorasden
v 1 ) Amachmens A4 Hem3
B A corshemeniionen « A, Datelertshed_c
B Gt
O # contens A Baend
O A coptureneyCode & Cortficasonhions ¢
D A, Createchly A et
O A crestionbisse
O A CureyComdaeType
[ A cureencyCode -
B A Datetertibed o
- B
D A LesfUpdassDate A BemT

O A Lenstpdasediny
O A LessspdsteLogin
v 0 Fhene

| Note: Don't move fields into the Icon field. You can't change the icons on this page.

In the runtime application, the search results are divided into 3 columns. The fields in Item 1to Item 3 in the
layout display in the first column, Item 4 and Item 5 in the second, and Item 6 and Item 7 in the third.

Each row of search results also includes the object name and a list of actions (not part of the Search Card
Layout).
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Followup demo

Demo
Gupta Atanu

Z= | E-mail
Gupta Atanu

Send Intro Email
Z=| E-mail
Gupta Atanu

= E-mai
Gupta Atanu

Search Results

Send Followup Email

Send an Intro Email

11/20,24 &:00 P

11,/20/24 700 PM

11727724

12713724

12714724

[=] emall M Try searching by keyword or add a filter

—-0-:

Filter by Object

Appointment
Nat started
Task
Complate
Tagk
Complete
Task

9. You can preview your new layout by clicking the Preview icon in the VB Studio tool bar.

Enable Filtering of Information Displayed in the Sales

Dashboard

You can enable 4 filters that salespeople can use to filter the information displayed in the sales dashboard: Time Period,
Teams, Territory, and Product Groups. When you enable the filters, they're available in all the sales dashboards in your
organization.

Sales Dashboard

=]

Try searching by keyword

Tirme: Period

Team Territony Produsct Grougs

Here's how to display the global filters:

Enable the Filters Using VB Studio

Open the custom Sales Dashboard where you're adding the filters.
Click Settings and Actions > Edit Page in Visual Builder Studio.
In VB Studio, select the App Uls tab.
On the Page Designer subtab, click Components.

On the Properties tab on the right, click Constants.

CUAWND

Click enableFilters.
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Hestal [ cpportusnities-detal [, sales-dashbosd
vt Listererd Eventi Types  Varigbled JavaSiript IS0M Senings
O [+ | FiteoCarwas = auto o | auto 100% = sales-dachboard | Sales g
| Wve | Design | Code a
L 1 | J ]
Companents (1 Condtants (5]
L
A, detpuilthetricCand ]
Sales Dashboard N
o Try searching by leeyword
0 dyrenicDashbosd *
My To-Dios Py e Harowarne
¥ pel v [] enableFiters 5
1 £12.71IM $12.TM Bt of sirhnes that et
B enableSearch ]
A pageSubcitie ¥

7. Use the Add Item (plus sign) icon to add rows for each filter you want to display. You can make the filters
available to all or restrict them to specific job roles. For example, only managers may need to filter by teams and
territories.

o Enter the following code to enable filters to all users:

Filter Code to Enable to All Users
Time Period timeFilter

Team teamFilter

Territory territoryFilter
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Filter Code to Enable to All Users
Product Groups productGroupFilter
€ enableFilters | Sales
A st of Strings that determing what filters are enabled in
the dashbsoard search bar
Defined by
] sales-dashboard | Sales
[] enableFiliers +
D] timeFilter > E’
(1] = | teamfiter |
[2] = territos M1_€I_ 3 m
(31 = | peedugtGroupfilier I
Usages

o To restrict a filter to specific job roles, enter code similar to the following. The sample code below restricts
the metric you specify in yourMetric to the sales manager roles provided by Oracle.

[[ $application.user.roles.includes ( 'ORA_ZBS_INSIDE SALES MANAGER JOB')
$application.user.roles.includes ('ORA ZBS_SALES MANAGER JOB') ? 'mymetric'

Enable Filters in the OTBI Analyses

You must include "is prompted" column filters in your analyses that match the filters you enable in the dashboard. The
following table lists the columns for opportunity pipeline visualizations.

Filters to Add in OTBI to Enable Sales Dashboard Filtering

Filter

Team

Territory

Time

Product Group

ORACLE

Folder

Sales - CRM Pipeline >
Employee > Sales Resource
Hierarchy/

Sales - CRM Pipeline > Territory >
Territory Hierarchy

Sales - CRM Pipeline >
Opportunity

Sales - CRM Pipeline > Product

Column

Current Level 1 Resource id

Level 1 Territory id

Expected Close Date

Sales Catalog Hierarchy 1 Name

Operator

is prompted

is prompted

is prompted

is prompted

'yourMetric'
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4 Filters

T Year is loss than or equal io @{CURRENT_YEAR]}
.ﬁHDI “Time","Year" BETWEEN (EXTRACT(YEAR FROM CURRENT_DATE) - 3) AND EXTRACT({YEAR FROM CURRENT_DATE)
ANDTY Current Level 1 Resource Id is prompted
MDT Laval 1 Tarritany Id is prompted
ANDT Sales Catalog Hierarchy 1 Mame is promgted
ANDT Expectad Closa Date is prompled

What do | do if the filters | apply aren't reflected in a sales
dashboard?

If the filters aren't reflected in a sales dashboard, try the following:

- Refresh the browser.

« Clear site data in your browser:

In the Chrome browser, right-click on the sales dashboard page.
Select Inspect.

Click Applications subtab.

Click Clear site data.

angoo

‘e Lo Elements Console  Sources  Metwork  Performance  Memory  Application >

Fe

Application 552 MB used out of 302,449 MB storage quota
» [ Manifest
#:;t Service workers
é Storage

Learn more

485 ME B Cache storage
66 ME M IndexedDE
143 kB B0 Service workers
55.2 MB Total

Storage
L Local storage

Session storage

Extension storage

IndexedDB

=
»
. [ Simulate customn storage quota
»

Cookies

Private state tokens

DOCOH®HMDB

Interest groups Clear site data [ including third-party cookies
*» B shared storage

- Check to make sure the OTBI analysis includes "is prompted" filters. See Enable Filters in the OTBI Analyses.
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7 Enable and Use Sales Dashboard
Personalization

Enable Sales Dashboard Personalization

Here's how to make it possible for users to configure their own sales dashboard versions using the content provided by
administrators and visualizations they themselves created in Express Reports.

Note: A video on Oracle Customer Connect summarizes this setup and runtime functionality.

1. Open the Sales Dashboard version where you want to enable editing.
2. Click Settings and Actions > Edit Page in Visual Builder Studio.
3. In VB Studio, select the App Uls tab.
4. Onthe Page Designer subtab, click Components.
5. On the Properties tab on the right, click Constants.
3l (Y opportunitics-detail O, sabes-dashiboard x
Events Typis iariabiles JavaScript EON Sattings
G | MwCawes v | sue | x| auts 100% - A — 3
Live  Design | Code o E
- Components Constants (& 3
Sales Dashboard E allowPersanslizstion e ¥
< Try searching by keyward A contentSryle ¥
by T Dicrs Pipeline Hardware 3 A delauliMetrbl s ¥
1 $12.71M $12.71M
Opportunities at Risk B dynamicDashboard e ¥
- - . Wi - O
Name = Accou < O 5 pﬂ: ~ Ar S o ¢ M [] enablefiitess ¥
MNew Po... Redlime Host  Jane S¢  10% £ 2621. 3/27/ E -
6. Click allowPersonalization and set to true.
7. Click dynamicDashboard and set to true.

8. You can now click Preview and use the Edit Page Layout button to personalize the sales dashboard.

P ® Q ‘ Publish | =

9. Publish to enable the personalization.
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Personalize Your Sales Dashboard

You can add tabs to your personal sales dashboard with your own content. You can include content provided by
administrators as well as visualizations that you created using the Express Reports tool.

Note: You can only edit and add content to the tabs that you added yourself. You can't remove or edit tabs added by
administrators using Visual Builder Studio.

Your personalization is available only to you. You can't share it.

Click the Edit Page Layout button to open the editing mode.

Sales Dashboard Edit Page Layout
S Try searching by k Ty Pegrisd Tearm Tareiong Procht Geoupd
My To-Das sl Pipeline
44 5 51,173.59873T
My Team's Opportunities
- - oy Win - . Close .
Mame 2 Account Owner = Probability - Amount = Date  ~ Action:
OB _Oppty_3_old OBIA Mew Technologhe Gabrielle Lee 0.52% % 51,000 4,11/10
OBlA_Oppty_19 0BIA New Education (( Gabrielle Lee 0.8% 50 4/19,/10
OBLA_Oppty_20 OBIA Mew Education (€ Gabrielle Lee  0.5% 30 &/19/10

Use the Library pane to add content. To move and remove items, hover over them and use the controls.

Library Pane Functions

Callout Feature Description

1 Use the Actions menu to restore the original dashboard.

2 Search for content.

3 The KPI filter displays the content available to create the top of a tab. The Visualizations filter lists the

content you can add to the tab itself.

4 Drag items into place using the handles.
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Actions - Exit Eclit Maode
Libsrary o
Library ®

Restore Defaults

O, search e
EPl  Visualization o

Hardware Opportunities _
Dorvist Chart

Hardware Opportunities
(=]

Hardware Opportunities
Fie Chart

My Tear's Pipeline for Sales
Manager

Furme] Chart

My Tear's Deal Size by
Resource for Sales Manager —
Bar Chart

My Team's Leads by
Resource for Sales Manager —_
Bar Chart

Add Tabs for Your Content

You must add a tab before you can add the tab content.

1. Inthe Library pane, click KPI to view the available KPIs that you can use for the top of your tab.

2. If you have sales administrator privileges and don't see a KPI that suits your needs, then you can create one of
your own. For details, see the topic.Create a Chart or a KPI from a Prompt

3. Drag one of the KPI next to one of the existing tabs on the sales dashboard.

Actionsg = Excit Eclit Made

Hargware Pipeling Hardvware Dpporiunities O Lt

Library ®
£12.71M £12,705,622 80 (8)

Hardware Oppartunities -
EPI o
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4. You're now ready to add content.

Add Content to Your Tab

You can add content only to tabs that you added yourself. You can have maximum of 5 items in a tab. You can add:

- Charts and tables created by administrators in the Visualization Configuration tool.
Express Reports that you've created and those shared with you by an administrator.

- Charts that you created by entering prompts in the Ask Oracle bar and saved in the library (available to sales
administrators only).

Note: The library includes all available visualizations and express reports. Some may not be applicable for your role in
the organization. You may not have permission to view the data in some charts, for example.

Here's how to add content:

In the Library tab, click the Visualizations button.
Search for what you want to add in the library.
Use the handles to drag the item into place on the dashboard.

If you have sales administrator privileges and don't see a chart that suits your needs, then you can create one
of your own. For details, see the topic Create a Chart or a KPI from a Prompt.

P WN

Move and Remove Content

You can only edit content that you've added.

To move an item, hover over it and drag using the handle.

- Toremove an item, hover over it and click Actions > Remove

Pipeline Hardware Pipeline
£12.71M $12.71IM
L L
Remove

Restoring the Default Dashboard

You can restore the original dashboard, by clicking Actions > Restore Defaults (the button at the top of the page).
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8 Visualization FAQs

How do | migrate visualization configurations to other
environments?

You can copy your visualization configurations to other environments using the Export Management and Import
Management tools.

To learn how to import and export visualization configurations, see the topic Import Your Visualizations in the
Visualization Configuration Tool using Import Management and the rest of the Understanding Import and Export
Management for Sales and Fusion Service guide.

Object: Visualization Configuration
Sample scripts:

- To export a specific configuration: ReportConfigNumber = 'CDRM_1002'

- To export all configurations: ReportConfigNumber IS NOT NULL

What do | do if a user doesn't see Visualization
Configuration in Application Composer?

Make sure that the user is assigned the following job roles provided by Oracle:

- ORA_ZCA_CUSTOMER_RELATIONSHIP_MANAGEMENT_APPLICATION_ADMINISTRATOR_JOB
- ORA_ZBS_SALES_ADMINISTRATOR_JOB

What do | do when Adaptive Search isn't available as a
source type for creating visualization?

Check to make sure that Oracle Sales in the Redwood User Experience is enabled. Both the Digital Sales Next Gen Ul and
Sales in the Redwood UX features in the Sales offering must be selected.

If the option isn’t visible even after enabling these features, then clear the browser cache.

Related Topics
« How can | enable Oracle Sales in the Redwood User Experience?
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What do | do when there's no data in a visualization?

Check to make sure that you've the same data access as the intended user of the visualization. For a saved search
visualization, check the list page. For an Oracle Transactional Business Intelligence (OTBI) analysis, check the results in
OTBI.

What do | do when | get the error "Select values for all
the required fields to generate the visualization"?

Make sure that you select all the values required for the visualization. For example, you must select a value for the x-axis
if you're displaying a bar chart. If all the values are selected, check if the column is a hierarchy column. Oracle Business
Intelligence hierarchical data can't be used in visualizations.

What do | do when | get the warning that the analysis has
more columns than selected?

Here's what to do when you see the warning that your analysis: "...has more columns than selected. Remove the
unused columns from the analysis else visualization may not show correct data."

The attributes that you use in your visualization must use all of the columns in your Oracle Transactional Business
Intelligence (OTBI) analysis. If you can't use all of the columns in the visualization, go back to the analysis and remove
the unused columns.

For example, a bar chart can support 2 dimensions, 1 metric, and you can have 1 filter attribute. If a report has more than
4 columns ( 3 dimensions and 1 fact), then you'll see this warning.

Visualizations can't show up correctly if the data in your analysis is aggregated or calculated with more columns than
chart can support.

Why does my visualization show a value higher than 100
percent?

Formatting a number in the visualization merely adds a percent symbol (%) to the visualization display. No calculation
is performed. You must perform calculations at the source of your visualization data. The same is true for currency
symbols.
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Why isn't the Meter Gauge and Tabular Chart available
for Adaptive Search visualizations?

The Meter Gauge and Tabular Chart visualization types are available only for Oracle Transactional Business Intelligence
(OTBI) analyses.

What visualizations are available for Oracle CX Sales
Mobile?

Here are the visualizations that are available in for CX Sales Mobile application:

- Pie

- Donut

- Bar (Stacked Bar)

- Area Charts

« Funnel

- Scatter

- Bubble

- Combo- Partially
Not supported are:

« Meter

+ Metric

- Tabular

- Line

- Combo (New updates to the charts)

How can | change the sort order in a table | created as a
visualization from an OTBI analysis?

You can change the sort order in the Oracle Transactional Business Intelligence (OTBI) analysis. Starting with update
25A, you can also change the sort order in the visualization itself.
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How many rows of data does a table visualization show?

The table you created as a visualization displays the first 100 rows of data using the sort order in the underlying Oracle
Transactional Business Intelligence (OTBI) analysis. Users can click the View All option on the table to display up to 2000
rows.

What do | do when an OTBI report isn't listed while
creating a visualization?

Check the following:

- Can you access the report in Oracle Transactional Business Intelligence (OTBI)?
- Is the correct top-level folder selected? If not, change the folder using the Select Catalog Folder button.

- Have you just created the analysis? New OTBI analyses take a while to appear in the visualization configuration
tool.

What do | do when the saved visualization configuration
doesn't render the chart?

Check if any columns in the Oracle Transactional Business Intelligence (OTBI) analysis were added or deleted. If they
were, then you must add the changed columns again because the visualization relies on column IDs from the analysis.

What do | do if tick mark labels repeat on a chart?

If tick marks repeat on a chart, you can switch the Number Format from Currency to Decimal to fix the issue. This is a
known issue that's in the process of being fixed.
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How come | don't see all the rows of my data in a table |
created as a visualization?

When you create a tabular visualization of the data from an Oracle Transactional Business Intelligence analysis, the
table shows a maximum of 100 rows. Users can click View All to see all of the records.

How come that, in the Sales Dashboard, | can't sort the
table created as a visualization?

You can't sort a table that's created as a visualization in the Sales Dashboard Ul. Instead, you must change the sort order
in the Oracle Transactional Business Intelligence (OTBI) analysis itself.
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What's the cause of the error "source doesn't have
enough value to generate a visualization"?

Check your report to see if you have the required number of attributes in the Oracle Transactional Business Intelligence
analytic that's the source of your data. For Metric Charts, you must include at least 1 Fact column. For other charts, you
must include at least 1 metric and dimension.

What's the likely cause of the message that tells me to
reduce the number of metrics for visualization?

There's a limit to the number of metrics that can be set to the "not null" value. The message "Reduce the number
of metrics for this visualization. You've exceeded the maximum number." appears when this maximum number is
exceeded.

What does it mean when | get the error "We couldn't
create a Bl session™?

The error indicates that the application is unable to connect to Oracle Business Intelligence (BI) Answers. Check to make
sure that Bl is running and that you can connect to Bl Answers.
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9 Sales Dashboard Configuration FAQs

How come | don't see the Sales Dashboard icon?

The Sales Dashboard is only visible to job roles with the privilege ZBS_VIEW_SALES_DASHBOARD_PRIV.
The privilege is available in the following job roles provided by Oracle:

- ORA_ZBS_SALES_REPRESENTATIVE_JOB
- ORA_ZBS_SALES_MANAGER_JOB

What do | do if a dashboard table or list doesn't show any
data from a saved search?

On the list page, check if the saved search is visible to the user. Saved searches can be specific to individual job roles or
hidden by administrators.

If the saved search shows up correctly on the list page, then you can troubleshoot using your browser to see if any of the
queries have failed:

1. In the Chrome browser, open the sales dashboard from the home page or preview it from Oracle Visual Builder
Studio.

Right-click and select Inspect.

Click Network.

Select the Preserve log, Disable cache, and Fetch/XHR options.
Enter queries in the Filter field.

Any query that's failed is labeled with an X in the Name column.
To troubleshoot, select the query and click Payload.

NouUuhWUuN
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What do | do if the dashboard is blank after | configured
it?

Inspect the page in the browser for any errors.

1. With the Sales Dashboard open, right-click and select Inspect.

2. Go to the Console tab and look for any errors.

3. Check the Network tab for any errors in network calls (highlighted in red).

4. If the cause of the error isn't clear, then capture the errors and contact Oracle support.

Why is a field, such as currency or date, not showing up
in the correct format?

You must add a template to format a field, including the forward slash character (/). Templates include the following:
/currencyTemplate, /dateTemplate, /singleSelectFCLTemplate, /emailTemplate, /phoneTemplate, /hyperlinkTemplate, /
percentageTemplate
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How do | troubleshoot saved search data that's not
showing up?

If the saved search with the issue is one of the saved searches provided by Oracle, then check if any of the saved
searches have been hidden and enable them again. If it's a custom saved search, then check that the correct saved
search is being used and ensure that the user has access to the data.

Use this troubleshooting method for any of these types of errors:

- An"Invalid Identifier for Saved Search" error on a Metric Card
- A dashboard table that shows: "No data to display.”

- A dashboard panel that shows the error: "Not able to fetch query definition"
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10 Appendix of Alternative Setup Methods

Create a Metric Card Directly in VB Studio

Instead of first creating the metric card contents as a visualization (the preferred method), you can create the whole
metric card directly in Oracle Visual Builder Studio. Here's an example of creating a metric card with the sum of
opportunities from a saved search.

Note: The code in this example is for opportunities. For values to use with other objects, see the topic Values to Use
in Code for Standard Components in Tables, Metric Cards, and List Views.

Create the Metric Card

1. Click Add Section in a metrics container copy. (The button is the plus sign highlighted in the screenshot).

£ Metrics Container  Sales Fragments

Shijandong

General  Sections (3

= Metrics Container

Section Rules Editor

4 Rules & & Rules

All Sections + Section
My TaDo's Metrics ;]
Sales Dashboard Metrics Container >
Cales Ma nager Fipeline Metrics >
Sales Representative Pipeline Metrics >

2. Click New Section at the top of the list.

Note: Although VB Studio makes it possible to duplicate the metric cards provided by Oracle, you must
instead add a new section, even if you're making a small change. You can't duplicate sections.

3. Inthe Create Section window, enter a title that's visible only during setup. You'll enter the actual tab title as a
parameter in the code. For example, enter Sales Manager Hardware Pipeline.
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4. C(lick the Go to Designer link.

¢ Mew Section

(8]
section

Tithe

Hardware Pipeline

Description

Label Hint

Access for Application Extensbons

Disabled | Enabled |

App extensions will be able to reference this

termplate.

Goto JSON

(w0 b0 Designer

sanpsadong

5. Click Code.

Design

Live

Code

Chapter 10
Appendix of Alternative Setup Methods

6. Your new Sales Manager Hardware Pipeline section displays empty placeholder temp1ate tags.

<template id="salesManagerHardwarePipelineMetrics">

</template>

~

On the Components palette, in the Filter field, enter cx-metric-card.

8. Drag and drop the cx-metric-card fragment to the template editor, between the template tags.

Getting Staried [ con

Ol cx-metric- X

w  Fragments

Components

Page Designer  Action Chains

2 fad ate £
[ _._-_d—-l"
[ iiel {5 A ] ] £/ tepplater
Y

e s-gletail Gl contagis % Contacts

Types

€ Refurn to page

Variabiles

-b Agtivities

leaSoript

@ 1

You action inserts the following code:

<oj-vb-fragment bridge="[[vbBridge]]" name="oracle cx fragmentsUI:cx-metric-card"></oj-vb-fragment>

9. Add the following class information to the fragment: class="o0j-flex oracle-cx-fragmentsUI-cx-fragment-full-

height.

The resulting code looks like this:

ORACLE
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<oj-vb-fragment bridge="[[vbBridge]]" name="oracle_cx_fragmentsUI:cx-metric-card" class="oj-flex oracle-
cx-fragmentsUI-cx-fragment-full-height></oj-vb-fragment>

10. Insert the following code for the metric card before the </oj-vb-£ragment> tag

a. Add the required resource parameter, which identifies the business object. The resource parameter is
different for each object.

Here's the resource parameter for opportunities, the object for pipeline information:

<oj-vb-fragment-param name="resource" value='[[ {"name": "opportunities", "primaryKey": "OptyId",
"puid": "OptyNumber", "endpoint": "cx" } 1]'></oj-vb-fragment-param>

For other supported business objects, see the list of resource parameters in Values to Use in Code for
Standard Components in Tables, Metric Cards, and List Views.

b. Add the required query parameter, which specifies the saved search that's the source of your data.

In this example, the source is a saved search with the ID ca£84b9d-b975-4b9d-b78e-41718b78£36e. YOU Can
obtain the ID of saved searches by inspecting the code in the Chrome browser as described the topic
How can I find the UUIDs for a saved search and the IDs for its filters in Oracle Sales in the Redwood User
Experience?.

<oj-vb-fragment-param name="query" value='[[ [{"type": "savedSearch", "params": [{"key":
"queryUuid", "value": "caf84b9d-b975-4b9d-b78e-41718b78£f36e"}]},
1 1]1'></oj-vb-fragment-param>

c. Optionally, you can filter the data from your source. For example, the sample parameters here filter the
data to include only open opportunities owned by a manager's subordinates.

Tip: The saved search may already include filters, so you might want to add filters there instead of
having another place to update in the future.

<oj-vb-fragment-param name="query" value='[[ [{"type": "savedSearch", "params": [{"key":
"queryUuid", "value": "caf84b9d-b975-4b9d-b78e-41718b78£36e"}]},
{"type": "gbe", "params": [{"key": "StatusCode", "operator": "in", "value": ["OPEN"] 1},

{"key": "RecordSet", "value": "ORA MYSUBORDSSALESTEAMOPTIES" }]},
1 1]1'></oj-vb-fragment-param>

d. Optionally, add badges that draw attention to critical information, as described in the section Add Badges
to the Metric Card.

e. Add the title parameter with the title that displays on the tab.

<oj-vb-fragment-param name="titleItem" value="[['Hardware Pipeline']]"></oj-vb-fragment-param>

f. To display the sum on the tab, add the aggregate parameter to calculate it. In this example, the
parameter calculates the sum of the opportunity revenue in the saved search:

<oj-vb-fragment-param name="aggregate" value="[[ {'field':
'PrimaryRevenue.RevnAmount', 'functionType': 'sum' } ]]"></oj-vb-fragment-param>

Here's sample code for the opportunity saved search without the optional filters and badges:

<template id="salesManagerHardwarePipelineMetrics">

<oj-vb-fragment bridge="[[vbBridge]]" name="oracle_cx_fragmentsUI:cx-metric-card" class="oj-flex
oracle-cx-fragmentsUI-cx-fragment-full-height">
<oj-vb-fragment-param name="resource" value='[[ {"name": "opportunities", "primaryKey": "OptyId",

"puid": "OptyNumber", "endpoint": "cx" } ]]'></oj-vb-fragment-param>
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<oj-vb-fragment-param name="query" value='[[ [{"type": "savedSearch", "params": [{"key": "queryUuid",

"value": "caf84b9d-b975-4b9d-b78e-41718b78£36e"}1},

1 1]1'></oj-vb-fragment-param>

<oj-vb-fragment-param name="aggregate" value="[[ {'field': 'PrimaryRevenue.RevnAmount', 'functionType':
'sum' } ]]"></oj-vb-fragment-param>

<oj-vb-fragment-param name="titleItem" value="[['Hardware Pipeline']]"></oj-vb-fragment-param>
</oj-vb-fragment>
</template>

11. Click Return to Page.

Add Badges to the Metric Card

First, determine the display conditions. Each condition is a range of aggregate sum numbers that display on the metric
card. For each range, you decide which type of badge to display. For example, you can configure this type of setup:

- If fewer than 5 overdue tasks exist, then don't show a badge at all.

« If 5-10 overdue tasks exist, then show a warning badge.

- If more than 10 overdue tasks exist, then show a critical badge.

When you define the display conditions for a metric card, the order of those conditions is important. Each condition
is evaluated in the order in which you define them, from top to bottom. Whichever condition is satisfied first is the
condition that's applied.

You can also configure the metric card so that the card always displays the same badge regardless of the aggregate sum
on the card.

The following table lists the badge properties that you can use to define a set of badges and display conditions:
Badge Properties

Badge Property Description

status - danger
- info
- neutral
- success
- warning

Each type of badge (status) displays a specific color, which you can't change.

Here's an example of a "danger" badge with the text "Critical":

M\,,r To-Dos Critical
18

min Lower limit of the display condition for a specific badge.

max Upper limit of the display condition for a specific badge.
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Badge Property Description

text Text that displays on the badge. Each type of badge (status) displays with default text, but you can
use this property to change it.

Here's a sample of the code that you can use to define a set of badges and display conditions:
[{status : "success", text : "All Good", min : "O", max : "10"}, {status : "warning", text : "Attention",
min : "11", max : "50"},{status : "danger", text : "Critical”, min : "51"}]
- Specify the type of badge to display (status).
- Define the conditions (min and max) that display each badge and an optional description.

- Indicate the badge text (text), for example, Warning or Problem.

« You can specify only a lower limit without an upper limit (to indicate an aggregate sum that's greater than 10,
for example).

+ You can add metaText Without any range conditions. So, if none of the ranges apply, then show a description on
the metric card.

Add Code to Display a Saved Search as a Table Not
Created As a Visualization

If you didn't create the table as a visualization (the recommended method), use these steps to add the code to display a
table from a saved search.

Note: The code in this example is for opportunities. For value to use with other objects, see the topic Values to Use in
Code for Standard Components in Tables, Metric Cards, and List Views.

1. On the Components palette, in the Filter field, enter cx-subview.
2. Dragand drop the cx-subview fragment to the template editor, between the template tags.

[E: =-dashboard X

Page Designer  Actior Event Lister Events Type:

» O fexsutrien] = = £ Return 1o page

H

& ~  Fragmenis @ )

i 2 <template id="opportunitiesAtRisk™»

= In x-sulwien - <0j-vb-fragment bridge="[[vbBridge]]” name="oracle_cx_fragmentsul:cx-subview

3. Add the following class information: class="o0j-flex oracle-cx-fragmentsUI-cx-fragment-full-height" t0O the
<oj-vb-fragment line before the > tag.

<oj-vb-fragment bridge="[[vbBridge]]" name="oracle cx fragmentsUI:cx-subview"
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class="oj-flex oracle-cx-fragmentsUI-cx-fragment-full-height">

4. Add the required resource parameter, which specifies the business object you're displaying. Each object
requires different values. Here are the values for opportunities:

<oj-vb-fragment-param name="resource"

value='[[ {"name": "opportunities", "primaryKey": "OptyId", "puid": "OptyNumber", "endpoint":
llcxll } ]] l>

</oj-vb-fragment-param>

The values for other business objects are listed in the topic Values to Use in Code for Standard Components in
Tables, Metric Cards, and List Views.

5. If you're displaying a table with opportunity revenue, you must insert this additional parameter because
opportunity revenue is a child object of opportunity:

<oj-vb-fragment-param name="child" value='[[ {"name": "ChildRevenue", "primaryKey": "RevnId"} ]]'></oj-
vb-fragment-param>

6. Add the required query parameter, which specifies the saved search that is the source of the data in your table:

<oj-vb-fragment-param name="query" value='[[ [{"type": "savedSearch", "params": [{"key": "queryUuid",
"value": "caf84b9d-b975-4b9d-b78e-41718b78£36e" }]}
1 11'></oj-vb-fragment-param>

In this example, the source is a saved search with the ID ca£84b9d-b975-4b9d-b78e-41718b78£36e. YOU Can obtain
the ID of saved searches by inspecting the code in the Chrome browser as described the topic How can I find
the UUIDs for a saved search and the IDs for its filters in Oracle Sales in the Redwood User Experience?.

7. Optionally, you can filter the data from your source. For example, the sample parameters here filter the data to
include only open opportunities owned by a manager's subordinates.

<oj-vb-fragment-param name="query" value='[[ [{"type": "savedSearch", "params": [{"key": "queryUuid",
"value": "caf84b9d-b975-4b9d-b78e-41718b78£36e"}1},

{"type": "gbe", "params": [{"key": "StatusCode", "operator": "in", "value": ["OPEN"] 1},

{"key": "RecordSet", "value": "ORA MYSUBORDSSALESTEAMOPTIES" }]},

1 11'></oj-vb-fragment-param>

8. Add the following style parameter. It specifies the size and position of the sections in the tab as you add more
sections. For details see the topic How Information Displays in a Sales Dashboard Tab as You Add Sections

<oj-vb-fragment-param name="style" value="[[ 'dashboard' ]]"></oj-vb-fragment-param>

9. Add the subviewLayoutld parameter to use the dashboard layout (dashboardLayout). The dashboard layout
specifies which columns are displayed in the table, in which order, and in which relative widths. The default
layout already includes the important columns, but you can create your own custom layouts as described in the
topic: Specify the Columns in a Sales Dashboard Table and Their Widths

<oj-vb-fragment-param name="subviewlLayoutId" value="[[ 'dashboardLayout' ]]"></oj-vb-fragment-param>

10. Add the title parameter, to specify the title that displays on the tab.

<oj-vb-fragment-param name="title" value="[['Hardware Opportunities]]"></oj-vb-fragment-param>

Sample Code for Opportunity Pipeline Table from a Saved Search

Here's the complete code for an opportunity table (leaving out the optional query parameters):

<template id="hardwareOpportunitiesInPipeline">
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<oj-vb-fragment bridge="[[vbBridge]]" name="oracle cx fragmentsUI:cx-subview"

class="oj-flex oracle-cx-fragmentsUI-cx-fragment-full-height">

<oj-vb-fragment-param name='"resource"

value='[[ {"name": "opportunities", "primaryKey": "OptyId", "puid": "OptyNumber", "endpoint": "cx" } 1]'>
</oj-vb-fragment-param>

<oj-vb-fragment-param name="query" value='[[ [{"type": "savedSearch", "params": [{"key": "queryUuid",
"value": "caf84b9d-b975-4b9d-b78e-41718b78£f36e" }]}

1 1]1'></oj-vb-fragment-param>

<oj-vb-fragment-param name="style" value="[[ 'dashboard' ]]"></oj-vb-fragment-param>
<oj-vb-fragment-param name="title" value="[['Hardware Opportunities']]"></oj-vb-fragment-param>
<oj-vb-fragment-param name="subviewLayoutId" value="[[ 'dashboardLayout' ]]"></oj-vb-fragment-param>
</oj-vb-fragment>
</template>

Sample Code for a Table with Opportunity Revenue

To add a table of opportunity revenue, you must add an additional revenue parameter because a revenue line is a child
object of opportunity:

<oj-vb-fragment-param name="child" value='[[ {"name": "ChildRevenue", "primaryKey": "RevnId"} ]]'></oj-vb-
fragment-param>

Here is sample code with the child fragment added:
<template id="revenueTable">

<oj-vb-fragment name="oracle cx_fragmentsUI:cx-subview" class="oj-flex oracle-cx-fragmentsUI-cx-fragment-
full-height" bridge="[[ vbBridge ]]">

<oj-vb-fragment-param name="resource" value='[[ {"name": "opportunities", "primaryKey": "OptyId", "puid":
"OptyNumber", "endpoint": "cx" } ]]'></oj-vb-fragment-param>

<oj-vb-fragment-param name="child" value='[[ {"name": "ChildRevenue", "primaryKey": "RevnId"} ]]'></oj-vb-
fragment-param>

<oj-vb-fragment-param name="query" value='[[ [{"type": "savedSearch", "params": [{"key": "queryUuid",

"value": "73b21b33-db08-4327-b£f30-88c3c9e0£70d" }]}] 1]'></oj-vb-fragment-param>
<oj-vb-fragment-param name="style" value="[[ 'dashboard' ]]"></oj-vb-fragment-param>
<oj-vb-fragment-param name="title" value="[['Revenue']]"></oj-vb-fragment-param>
<oj-vb-fragment-param name="subviewlLayoutId" value="[[ 'dashboardLayout' ]]"></oj-vb-fragment-param>
</oj-vb-fragment>
</template>
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